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Safety information
Connect the power cord to a properly grounded electrical outlet that is near the product and easily accessible.
Do not place or use this product near water or wet locations.
CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or performance of
procedures other than those specified herein may result in hazardous radiation exposure.
This product uses a printing process that heats the print media, and the heat may cause the media to release emissions.
You must understand the section in your operating instructions that discusses the guidelines for selecting print media
to avoid the possibility of harmful emissions.
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.
CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet.
• Disconnect all cords and cables from the printer before moving it.
• Lift the printer off the optional tray, and then set it aside instead of trying to lift the tray and printer at the same
time.
Note: Use the handholds located on both sides of the printer to lift it.
Use only the power cord provided with this product or the manufacturer's authorized replacement.
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.
CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and telephone system
connections) are properly installed in their marked plug-in ports.
This product is designed, tested, and approved to meet strict global safety standards with the use of specific
manufacturer's components. The safety features of some parts may not always be obvious. The manufacturer is not
responsible for the use of other replacement parts.
CAUTION—POTENTIAL INJURY: Do not cut, twist, bind, crush, or place heavy objects on the power cord. Do not
subject the power cord to abrasion or stress. Do not pinch the power cord between objects such as furniture
and walls. If any of these things happen, a risk of fire or electrical shock results. Inspect the power cord regularly
for signs of such problems. Remove the power cord from the electrical outlet before inspecting it.
Refer service or repairs, other than those described in the user documentation, to a professional service person.
CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the printer, unplug
the power cord from the wall outlet and disconnect all cables from the printer before proceeding.
CAUTION—SHOCK HAZARD: Do not set up this product or make any electrical or cabling connections, such as
the power supply cord or telephone, during a lightning storm.
SAVE THESE INSTRUCTIONS.
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Learning about the printer
Thank you for choosing this printer!
We've worked hard to make sure it will meet your needs.
To start using your new printer right away, use the setup materials that came with the printer, and then skim the User’s
Guide to learn how to perform basic tasks. To get the most out of your printer, read the User’s Guide carefully, and
make sure you check the latest updates on our Web site.
We're committed to delivering performance and value with our printers, and we want to make sure you're satisfied. If
you do encounter any problems along the way, one of our knowledgeable support representatives will be delighted to
help you get back on track fast. And if you find something we could do better, please let us know. After all, you are the
reason we do what we do, and your suggestions help us do it better.

Finding information about the printer
What are you looking for?

Find it here

Initial setup instructions:

Setup documentation—The setup documentation came
with the printer and is also available at
http://support.lexmark.com.

• Connecting the printer
• Installing the printer software
Additional setup and instructions for using the printer:

•
•
•
•
•
•
•
•

Selecting and storing paper and specialty media
Loading paper
Configuring printer settings

User's Guide and Quick Reference Guide—The guides may
be available on the Software and Documentation CD.
For more information, visit
http://support.lexmark.com.

Viewing and printing documents and photos
Setting up and using the printer software
Configuring the printer on a network
Caring for and maintaining the printer
Troubleshooting and solving problems

Instructions for:

• Connecting the printer to an Ethernet network
• Troubleshooting printer connection problems
Help using the printer software

Networking Guide—Open the Software and
Documentation CD, and then look for Printer and
Software Documentation under the Pubs folder. From
the list of publications, click the Networking Guide link.
Windows or Mac Help—Open a printer software program
or application, and then click Help.
Click

?

to view context‑sensitive information.

Notes:

• Help is automatically installed with the printer
software.

• The printer software is located in the printer
program folder or on the desktop, depending on
your operating system.
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What are you looking for?

Find it here

The latest supplemental information, updates, and customer
support:

Lexmark Support Web site—
http://support.lexmark.com

•
•
•
•
•

Documentation
Driver downloads
Live chat support
E‑mail support
Voice support

Note: Select your country or region, and then select
your product to view the appropriate support site.
Support telephone numbers and hours of operation for
your country or region can be found on the Support Web
site or on the printed warranty that came with your
printer.
Record the following information (located on the store
receipt and at the back of the printer), and have it ready
when you contact customer support so that they may
serve you faster:

•
•
•
•
Warranty information

Machine Type number
Serial number
Date purchased
Store where purchased

Warranty information varies by country or region:

• In the U.S.—See the Statement of Limited Warranty
included with this printer, or at
http://support.lexmark.com.

• In other countries and regions—See the printed
warranty that came with your printer.

Selecting a location for the printer
When selecting a location for the printer, leave enough room to open trays, covers, and doors. If you plan to install any
options, leave enough room for them also. It is important to:

• Make sure airflow in the room meets the latest revision of the ASHRAE 62 standard.
• Provide a flat, sturdy, and stable surface.
• Keep the printer:
– Away from the direct airflow of air conditioners, heaters, or ventilators
– Free from direct sunlight, humidity extremes, or temperature fluctuations
– Clean, dry, and free of dust
• Allow the following recommended amount of space around the printer for proper ventilation:
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1
4
2
3

1

102 mm (4 in.)

2

508 mm (20 in.)

3

152 mm (6 in.)

4

76 mm (3 in.)

5

254 mm (10 in.)

Printer configurations
Basic model
Note: Your printer model may have come with a 650‑sheet duo drawer.
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1

4

3

1

Standard exit bin

2

Standard 250‑sheet tray (Tray 1)

3

Manual feeder

4

Printer control panel

2

Fully configured model
The following illustration shows a fully configured printer model with a 650‑sheet duo drawer and an optional
550‑sheet tray:
Note: Some printer models may not support the optional 550‑sheet tray.
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1

2

3

1

Standard 250‑sheet tray (Tray 1)

2

650‑sheet duo drawer with integrated multipurpose feeder (Tray 2)

3

Optional 550‑sheet tray

Understanding the printer control panel
1

2

3

Menus

Back

7

6

Stop

5

4
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Description

1

Display

Shows messages that communicate the status of the printer

2

Select

Press

3

Indicator light

Indicates the printer status:

•
•
•
•
4

Stop/Cancel

to initiate action on a menu item.

Off—The printer is off.
Blinking green—The printer is warming up, processing data, or printing.
Solid green—The printer is on, but idle.
Blinking red—Operator intervention is needed.

Stops all printer activity
A list of options is offered once Stopped appears on the display.

5

Navigation buttons

Scrolls through menus, submenus, or settings on the display

6

Back

Returns the display to the previous screen

7

Menu

Opens the menu index
Note: The menus are available only when the printer is in the Ready state.
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Additional printer setup
Installing internal options
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.
You can customize your printer connectivity and memory capacity by adding optional cards. The instructions in this
section explain how to install the available cards; you can also use them to locate a card for removal.
Note: Options are available only for some printer models.

Available options
Note: Certain options are not available on selected printer models.

Memory cards
• Printer memory
• Flash memory
• Font cards

Additional printer setup
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Accessing the system board to install internal options
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

1 Access the system board at the back of the printer.
2 Turn the screws counterclockwise to remove them.

3 Gently pull the cover away from the printer, and then remove it.
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4 Locate the appropriate connector on the system board.
Warning—Potential Damage: System board electrical components are easily damaged by static electricity.
Touch something metal on the printer before touching any system board electronic components or connectors.

1

2

1

Flash memory card connector

2

Memory card connector

Additional printer setup
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Installing a memory card
The system board has one connector for an optional memory card.
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

1 Access the system board.

2 Open both latches on the connector completely.
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3 Unpack the memory card.
Note: Avoid touching the connection points along the edge of the card.

4 Align the notch on the memory card with the ridge on the connector.
5 Push the memory card straight into the connector until it snaps into place. Make sure each latch fits over the notch
located on either side of the memory card.

1

Notch

2

Ridge

6 Reinstall the system board access cover.
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Installing a flash memory card
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

1 Access the system board.

2 Unpack the memory card.
Note: Avoid touching the connection points along the edge of the card.

3 Holding the card by its sides, align the plastic pins on the card with the holes on the system board. This ensures the
metal pins line up correctly as well.
11

22
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1

Plastic pins

2

Metal pins

4 Push the card firmly into place.

Notes:

• The entire length of the connector on the card must touch and be flush against the system board.
• Be careful not to damage the connectors.
5 Reinstall the system board cover.

18
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Installing hardware options
Installing an optional tray or drawer
The printer supports two additional input sources: an optional 550‑sheet tray and a 650‑sheet duo drawer (Tray 2) with
an integrated multipurpose feeder.
Note: Some printer models may not support the optional 550‑sheet tray.
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

1 Unpack the optional 550‑sheet tray, and then remove all packing material and the dust cover.
2 Place the tray in the location chosen for the printer.
Note: If you are installing both the optional tray and the 650‑sheet duo drawer, the optional 550‑sheet tray
must always be installed as the first tray (configuring from the bottom up).

3 Align a 650‑sheet duo drawer with the optional 550‑sheet tray, and then lower it into place.
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4 Align the printer with the 650‑sheet duo drawer, and then lower the printer into place.

5 Install the dust covers.
Note: Once the printer software and any options are installed, it may be necessary to manually add the options in
the printer driver to make them available for print jobs. For more information, see “Updating available options in the
printer driver” on page 23.

Attaching cables
Connect the printer to the computer using a USB cable or an Ethernet cable. A USB port requires a USB cable. Be sure
to match the USB symbol on the cable with the USB symbol on the printer. Match the appropriate Ethernet cable to
the Ethernet port.
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1

2

1

Ethernet port

2

USB port

Verifying printer setup
Printing a menu settings page
Print menu settings pages to review the current menu settings and to verify if the printer options are installed correctly.
Note: If you have not made any menu item settings changes yet, then the menu settings pages list all the factory
default settings. Once you select and save other settings from the menus, they replace the factory default settings as
user default settings. A user default setting remains in effect until you access the menu again, choose another value,
and save it.

1 Make sure that the printer is on and Ready appears.
2 From the printer control panel, press

.

3 Press the arrow buttons until Reports appears, and then press

.

4 Press the arrow buttons until Menu Settings Page appears, and then press
After the menu settings pages print, Ready appears.

.
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Printing a network setup page
If the printer is attached to a network, print a network setup page to verify the network connection. This page also
provides important information that aids network printing configuration.

1 Make sure the printer is on and Ready appears.
2 From the printer control panel, press

.

3 Press the arrow buttons until Reports appears, and then press

.

4 Press the arrow buttons until Network Setup Page appears, and then press

.

After the network setup page prints, Ready appears.

5 Check the first section on the network setup page, and confirm that Status is “Connected.”
If Status is “Not Connected,” the LAN drop may not be active, or the network cable may be malfunctioning. Consult
a system support person for a solution, and then print another network setup page.

Setting up the printer software
Installing the printer software
Notes:

• If you installed the printer software on the computer before but need to reinstall the software, then uninstall
the current software first.

• Close all open software programs before installing the printer software.
1 Obtain a copy of the software installer package.
• From the Software and Documentation CD that came with your printer.
• From our Web site:
Go to http://support.lexmark.com, and then navigate to:
SUPPORT & DOWNLOAD > select your printer > select your operating system

2 Double‑click the software installer package.
Wait for the installation dialog to appear.
If you are using a Software and Documentation CD and the installation dialog does not appear, then do the following:

In Windows 8
From the Search charm, type run, and then navigate to:
Apps list > Run > type D:\setup.exe > OK.

In Windows 7 or earlier
a Click
or click Start, and then click Run.
b In the Start Search or Run dialog, type D:\setup.exe.
c Press Enter, or click OK.
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In Macintosh
Click the CD icon on the desktop.
Note: D is the letter of your CD or DVD drive.

3 Click Install, and then follow the instructions on the computer screen.

Updating available options in the printer driver
When any hardware options are installed, you may need to manually add the options in the printer driver to make
them available for use.

For Windows users
1 Open the printers folder.
In Windows 8
From the Search charm, type run, and then navigate to:
Apps list > Run > type control printers > OK
In Windows 7 or earlier

a Click
or click Start, and then click Run.
b In the Start Search or Run dialog, type control printers.
c Press Enter, or click OK.
2 Depending on your device, do either of the following:
• Press and hold the printer you want to update.
• Right‑click the printer you want to update.
3 From the menu that appears, do either of the following:
• For Windows 7 or later, select Printer properties.
• For earlier versions, select Properties.
4 Click the Configuration tab.
5 Do either of the following:
• Click Update Now ‑ Ask Printer.
• Under Configuration Options, manually add any installed hardware options.
6 Click Apply.

For Macintosh users
1 From the Apple menu, navigate to either of the following:
• System Preferences > Print & Scan > select your printer > Options & Supplies > Driver
• System Preferences > Print & Fax > select your printer > Options & Supplies > Driver
2 Add any installed hardware options, and then click OK.
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Setting up wireless printing
Note: A Service Set Identifier (SSID) is a name assigned to a wireless network. Wireless Encryption Protocol (WEP)
and Wi-Fi Protected Access (WPA) are types of security used on a network.

Preparing to set up the printer on a wireless network
Notes:

• Make sure your access point (wireless router) is turned on and is working properly.
• Do not connect the installation or network cables until prompted to do so by the setup software.
Make sure you have the following information before setting up the printer on a wireless network:

• SSID—The SSID is also referred to as the network name.
• Wireless Mode (or Network Mode)—The mode is either infrastructure or ad hoc.
• Channel (for ad hoc networks)—The channel defaults to automatic for infrastructure networks.
Some ad hoc networks will also require the automatic setting. Check with your system support person if you are
not sure which channel to select.

• Security Method—There are four basic options for Security Method:
– WEP key
If your network uses more than one WEP key, then enter up to four in the provided spaces. Select the key
currently in use on the network by selecting the default WEP transmit key.

– WPA or WPA2 preshared key or passphrase
WPA includes encryption as an additional layer of security. The choices are AES or TKIP. Encryption must be set
for the same type on the router and on the printer, or the printer will not be able to communicate on the
network.

– 802.1X–RADIUS
If you are installing the printer on an 802.1X network, then you may need the following:

•
•
•
•

Authentication type
Inner authentication type
802.1X user name and password
Certificates

– No security
If your wireless network does not use any type of security, then you will not have any security information.
Note: Using an unsecured wireless network is not recommended.
Notes:

– If you do not know the SSID of the network that your computer is connected to, then launch the wireless utility
of the computer network adapter, and then look for the network name. If you cannot find the SSID or the
security information for your network, then see the documentation that came with the access point or contact
your system support person.

– To find the WPA/WPA2 preshared key or passphrase for the wireless network, see the documentation that
came with the access point, see the Embedded Web Server associated with the access point, or consult your
system support person.
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Installing the printer on a wireless network (Windows)
Before installing the printer on a wireless network, make sure:

• Your wireless network is set up and is working properly.
• The computer you are using is connected to the same wireless network where you want to set up the printer.
1 Connect the power cord to the printer, then to a properly grounded electrical outlet, and then turn on the printer.

1

2

Note: Make sure the printer and the computer are fully on and ready.
Warning—Potential Damage: Do not connect the USB cable until instructed to do so on the computer screen.

2 Obtain a copy of the software installer package.
• From the Software and Documentation CD that came with your printer.
• From our Web site:
Go to http://support.lexmark.com, and then navigate to:
SUPPORT & DOWNLOAD > select your printer > select your operating system

3 Double‑click the software installer package.
Wait for the installation dialog to appear.
If you are using the Software and Documentation CD and the installation dialog does not appear, then do the
following:

In Windows 8
From the Search charm, type run, and then navigate to:
Apps list > Run > type D:\setup.exe > OK

In Windows 7 or earlier
a Click
or click Start, and then click Run.
b In the Start Search or Run dialog, type D:\setup.exe.
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c Press Enter or click OK.
Note: D is the letter of your CD or DVD drive.

4 Click Install, and then follow the instructions on the computer screen.
5 Select Wireless connection when asked to choose a connection type.
6 From the Wireless Configuration dialog, select Guided Setup (Recommended).
Note: Choose Advanced Setup only if you want to customize your installation.

7 Temporarily connect a USB cable between the computer on the wireless network and the printer.

1

2

Note: After the printer is configured, the software will instruct you to disconnect the temporary USB cable so
you can print wirelessly.

8 Follow the instructions on the computer screen.
Note: For more information on allowing other computers on the network to use the wireless printer, see the
Networking Guide.

Installing the printer on a wireless network (Macintosh)
Note: Make sure to disconnect the Ethernet cable when installing the printer on a wireless network.

Prepare to configure the printer
1 Connect the power cord to the printer, then to a properly grounded electrical outlet, and then turn on the printer.

1

2
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2 Locate the printer MAC address.
a From the printer control panel, navigate to:
> Reports >

> Network Setup Page >

or
> Reports > Network Setup Page

b In the Standard Network Card section, look for UAA (MAC).
Note: You will need this information later.

Enter the printer information
1 Access the AirPort options:
In Mac OS X version 10.5 or later
From the Apple menu, navigate to either of the following:

• System Preferences > Network > Wi‑Fi
• System Preferences > Network > AirPort
In Mac OS X version 10.4
From the Finder, navigate to:
Applications > Internet Connect > AirPort

2 From the Network Name pop‑up menu, select print server [yyyyyy], where the y’s are the last six digits of the MAC
address located on the MAC address sheet.

3 Open a Web browser.
4 From the Bookmarks menu, select Show or Show All Bookmarks.
5 Under COLLECTIONS, select Bonjour or Rendezvous, and then double‑click the printer name.
Note: The application referred to as Rendezvous in Mac OS X version 10.2 is now called Bonjour by Apple Inc.

6 From the Embedded Web Server, navigate to the location of the wireless settings information.
Configure the printer for wireless access
1 Type the network name (SSID) in the appropriate field.
2 Select Infrastructure as your Network Mode setting if you are using an access point (wireless router).
3 Select the type of security you want to use to protect the wireless network.
4 Enter the security information necessary for the printer to connect to the wireless network.
5 Click Submit.
6 Open the AirPort application on the computer:
In Mac OS X version 10.5 or later
From the Apple menu, navigate to either of the following:

• System Preferences > Network > Wi‑Fi
• System Preferences > Network > AirPort

Additional printer setup
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In Mac OS X version 10.4
From the Finder, navigate to:
Applications > Internet Connect > AirPort

7 From the Network pop‑up menu, select the name of the wireless network.
Configure your computer to use the printer wirelessly
To print on a network printer, each Macintosh user must install a custom printer driver file and create a print queue in
the Printer Setup Utility or Print Center.

1 Install a printer driver file on the computer:
a Obtain a copy of the software installer package.
• From the Software and Documentation CD that came with your printer.
• From our Web site:
Go to http://support.lexmark.com, and then navigate to:
SUPPORT & DOWNLOAD > select your printer > select your operating system

b
c
d
e
f

Double‑click the installer package for the printer.
Follow the instructions on the computer screen.
Select a destination, and then click Continue.
From the Easy Install screen, click Install.
Type the user password, and then click OK.
All necessary applications are installed in the computer.

g Click Close when the installation is complete.
2 Add the printer:
a For IP printing:
In Mac OS X version 10.5 or later
1 From the Apple menu, navigate to either of the following:

• System Preferences > Print & Scan
• System Preferences > Print & Fax
2
3
4
5

Click +.
If necessary, click Add Printer or Scanner or Add Other Printer or Scanner.
Click the IP tab.
Type the IP address of the printer in the address field, and then click Add.

In Mac OS X version 10.4
1 From the Finder, navigate to:
Applications > Utilities
2 Double‑click Printer Setup Utility or Print Center.
3 From the Printer List, choose Add, and then click IP Printer.
4 Type the IP address of the printer in the address field, and then click Add.

b For AppleTalk printing:
Notes:

• Make sure AppleTalk is activated on your printer.
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• This feature is supported only in Mac OS X version 10.5 or earlier.
In Mac OS X version 10.5
1 From the Apple menu, navigate to:
System Preferences > Print & Fax
2 Click +, and then navigate to:
AppleTalk > select the printer from the list > Add
In Mac OS X version 10.4
1 From the Finder, navigate to:
Applications > Utilities
2 Double‑click Printer Setup Utility or Print Center.
3 From the Printer List, click Add.
4 Click Default Browser tab > More Printers.
5 From the first pop‑up menu, select AppleTalk.
6 From the second pop‑up menu, select Local AppleTalk Zone.
7 Select the printer from the list, and then click Add.

Installing the printer on an Ethernet network
Note: Make sure you have completed the initial setup of the printer.

For Windows users
1 Obtain a copy of the software installer package.
• From the Software and Documentation CD that came with your printer.
• From our Web site:
Go to http://support.lexmark.com, and then navigate to:
SUPPORT & DOWNLOAD > select your printer > select your operating system

2 Double‑click the software installer package.
Wait for the installation dialog to appear.
If you are using the Software and Documentation CD and the installation dialog does not appear, then do the
following:

In Windows 8
From the Search charm, type run, and then navigate to:
Apps list > Run > type D:\setup.exe > OK

In Windows 7 or earlier
a Click
or click Start, and then click Run.
b In the Start Search or Run dialog, type D:\setup.exe.
c Press Enter or click OK.
Note: D is the letter of your CD or DVD drive.
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3 Click Install, and then follow the instructions on the computer screen.
Note: To configure the printer using a static IP address, IPv6, or scripts, select Advanced Options >
Administrator Tools.

4 Select Ethernet connection, and then click Continue.
5 Attach the Ethernet cable when instructed to do so.
6 Select the printer from the list, and then click Continue.
Note: If the configured printer does not appear in the list, then click Modify Search.

7 Follow the instructions on the computer screen.

For Macintosh users
1 Allow the network DHCP server to assign an IP address to the printer.
2 Obtain the printer IP address either:
• From the printer control panel
• From the TCP/IP section in the Network/Ports menu
• By printing a network setup page or menu settings page, and then finding the TCP/IP section
Note: You will need the IP address if you are configuring access for computers on a different subnet than the printer.

3 Install the printer driver on the computer.
a Double‑click the installer package for the printer.
b Follow the instructions on the computer screen.
c Select a destination, and then click Continue.
d From the Easy Install screen, click Install.
e Type the user password, and then click OK.
All the necessary applications are installed on the computer.

f Click Close when the installation is complete.
4 Add the printer.
• For IP printing:
In Mac OS X version 10.5 or later
a From the Apple menu, navigate to either of the following:
– System Preferences > Print & Scan
– System Preferences > Print & Fax
b Click +.
c If necessary, click Add Printer or Scanner or Add Other Printer or Scanner.
d Click the IP tab.
e Type the printer IP address in the address field, and then click Add.
In Mac OS X version 10.4 or earlier
a From the Finder, navigate to:
Applications > Utilities
b Double‑click Printer Setup Utility or Print Center.

Additional printer setup

c From the printer list, click Add, and then click IP Printer.
d Type the scanner IP address in the address field, and then click Add.
• For AppleTalk printing:
Notes:

– Make sure AppleTalk is activated on your printer.
– This feature is supported only in Mac OS X version 10.5 or earlier.
In Mac OS X version 10.5
a From the Apple menu, navigate to:
System Preferences > Print & Fax

b Click +, and then navigate to:
AppleTalk > select your printer > Add

In Mac OS X version 10.4 or earlier
a From the Finder, navigate to:
b
c
d
e
f
g

Applications > Utilities
Double‑click Printer Setup Utility or Print Center.
From the printer list, click Add.
Click Default Browser tab > More Printers.
From the first pop‑up menu, select AppleTalk.
From the second pop‑up menu, select Local AppleTalk Zone.
Select the device from the list, and then click Add.

Note: If the scanner does not show up in the list, then you may need to add it using the IP address. For more
information, contact your system support person.
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Minimizing your printer's environmental impact
Lexmark is committed to environmental sustainability and is continually improving its printers to reduce their impact
on the environment. We design with the environment in mind, engineer our packaging to reduce materials, and provide
collection and recycling programs. For more information, see:

• The Notices chapter
• The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment
• The Lexmark recycling program at www.lexmark.com/recycle
By selecting certain printer settings or tasks, you may be able to reduce your printer's impact even further. This chapter
outlines the settings and tasks that may yield a greater environmental benefit.

Saving paper and toner
Studies show that as much as 80% of the carbon footprint of a printer is related to paper usage. You can significantly
reduce your carbon footprint by using recycled paper and the following printing suggestions, such as printing on both
sides of the paper and printing multiple pages on one side of a single sheet of paper.
For information on how you can quickly save paper and energy using one printer setting, see “Using Eco‑Mode” on
page 34.

Using recycled paper and other office papers
As an environmentally conscientious company, Lexmark supports the use of recycled paper produced specifically for
use in laser (electrophotographic) printers.
While no blanket statement can be made that all recycled paper will feed well, Lexmark consistently tests papers that
represent recycled cut size copier papers available on the global market. This scientific testing is conducted with rigor
and discipline. Many factors are taken into consideration both separately and as a whole, including the following:

•
•
•
•
•
•
•
•

Amount of post-consumer waste (Lexmark tests up to 100% post-consumer waste content.)
Temperature and humidity conditions (Testing chambers simulate climates from all over the world.)
Moisture content (Business papers should have low moisture: 4–5%.)
Bending resistance and proper stiffness means optimum feeding through the printer.
Thickness (impacts how much can be loaded into a tray)
Surface roughness (measured in Sheffield units, impacts print clarity and how well toner fuses to the paper)
Surface friction (determines how easily sheets can be separated)
Grain and formation (impacts curling, which also influences the mechanics of how the paper behaves as it moves
through the printer)

• Brightness and texture (look and feel)
Recycled papers are better than ever; however, the amount of recycled content in a paper affects the degree of control
over foreign matter. And while recycled papers are one good path to printing in an environmentally responsible manner,
they are not perfect. The energy required to de-ink and deal with additives such as colorants and “glue” often generates
more carbon emissions than does normal paper production. However, using recycled papers enables better resource
management overall.
Lexmark concerns itself with the responsible use of paper in general based on life cycle assessments of its products. To
gain a better understanding of the impact of printers on the environment, the company commissioned a number of
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life cycle assessments and found that paper was identified as the primary contributor (up to 80%) of carbon emissions
caused throughout the entire life of a device (from design to end-of-life). This is due to the energy-intensive
manufacturing processes required to make paper.
Thus, Lexmark seeks to educate customers and partners on minimizing the impact of paper. Using recycled paper is
one way. Eliminating excessive and unnecessary paper consumption is another. Lexmark is well-equipped to help
customers minimize printing and copying waste. In addition, the company encourages purchasing paper from suppliers
who demonstrate their commitment to sustainable forestry practices.
Lexmark does not endorse specific suppliers, although a converter’s product list for special applications is maintained.
However, the following paper choice guidelines will help alleviate the environmental impact of printing:

1 Minimize paper consumption.
2 Be selective about the origin of wood fiber. Buy from suppliers who carry certifications such as the Forestry
Stewardship Council (FSC) or The Program for the Endorsement of Forest Certification (PEFC). These certifications
guarantee that the paper manufacturer uses wood pulp from forestry operators that employ environmentally and
socially responsible forest management and restoration practices.

3 Choose the most appropriate paper for printing needs: normal 75 or 80 g/m2 certified paper, lower weight paper,
or recycled paper.

Unacceptable paper examples
Test results indicate that the following paper types are at risk for use with laser printers:

•
•
•
•

Chemically treated papers used to make copies without carbon paper, also known as carbonless papers

•
•
•
•
•

Coated papers (erasable bond), synthetic papers, thermal papers

Preprinted papers with chemicals that may contaminate the paper
Preprinted papers that can be affected by the temperature in the printer fuser
Preprinted papers that require a registration (the precise location on the page) greater than ± 2.3 mm (± 0.9 in.),
such as optical character recognition (OCR) forms. In some cases, registration can be adjusted with a software
application to successfully print on these forms.)
Rough-edged, rough or heavily textured surface papers or curled papers
Recycled papers that fail EN12281:2002 (European testing)
Paper weighing less than 60 g/m2 (16 lb)
Multiple part forms or documents

For more information about Lexmark, visit www.lexmark.com. General sustainability-related information can be found
at the Environmental Sustainability link.

Conserving supplies
There are a number of ways you can reduce the amount of paper and toner you use when printing. You can:

Use both sides of the paper
If your printer model supports duplex printing, you can control whether print appears on one or two sides of the paper
by selecting 2‑sided printing from the Print dialog or the Lexmark Toolbar.
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Place multiple pages on one sheet of paper
You can print up to 16 consecutive pages of a multiple‑page document onto one side of a single sheet of paper by
selecting a setting from the Multipage printing (N‑Up) section of the Print dialog.

Check your first draft for accuracy
Before printing or making multiple copies of a document:

• Use the preview feature, which you can select from the Print dialog or the Lexmark Toolbar, to see how the document
will look before you print it.

• Print one copy of the document to check its content and format for accuracy.

Avoid paper jams
Carefully select and load paper to avoid paper jams. For more information, see “Avoiding jams” on page 118.

Saving energy
Using Eco‑Mode
Use Eco‑Mode to quickly select one or more ways to reduce your printer's environmental impact.
Note: See the table for the multiple settings that change when you select an Eco‑Mode setting.
Choose

To

Energy

Reduce energy use, especially when the printer is idle.

• Printer engine motors do not start until a job is ready to print. You may notice a short delay before the
first page is printed.

• The printer enters Power Saver mode after one minute of inactivity.
Paper

Duplex is enabled on printer models supporting duplex.

Energy/Paper Use all the settings associated with Energy mode and Paper mode.
Off

Use factory default settings for all settings associated with Eco‑Mode. This setting supports the performance
specifications for your printer.

To select an Eco‑Mode setting:

1 From the printer control panel, press

.

2 Press the arrow buttons until Settings appears, and then press

.

3 Press the arrow buttons until General Settings appears, and then press
4 Press the arrow buttons until Eco‑Mode appears, and then press
5 Select the setting you want, and then press
Submitting changes appears.

.

.

.
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Reducing printer noise
Use Quiet Mode to reduce the printer noise.
Note: See the table for the multiple settings that change when you select a Quiet Mode setting.
Choose

To

On

Reduce printer noise.

• You may notice a reduction in processing speed.
• Printer engine motors do not start until a job is ready to
print. You may notice a short delay before the first page
is printed.

• Fans run at a reduced speed or are turned off.
• If your printer has faxing capability, fax sounds are
reduced or disabled, including those made by the fax
speaker and ringer.
Off

Use factory default settings. This setting supports the
performance specifications for your printer.

To select a Quiet Mode setting:

1 From the printer control panel, press

.

2 Press the arrow buttons until Settings appears, and then press

.

3 Press the arrow buttons until General Settings appears, and then press
4 Press the arrow buttons until Quiet Mode appears, and then press
5 Select the setting you want, and then press

.

.

.

Submitting changes appears.

Adjusting Power Saver
1 Make sure the printer is on and Ready appears.
2 From the printer control panel, press

.

3 Press the arrow buttons until Settings appears, and then press

.

4 Press the arrow buttons until General Settings appears, and then press
5 Press the arrow buttons until Timeout appears, and then press

.

.

6 Press the arrow buttons until Power Saver appears, and then press

.

7 Press the arrow buttons to enter the number of minutes for the printer to wait before entering the Power Saver
mode. Available settings range from 1–240 minutes.

8 Press

.

Submitting changes appears.

9 Press

, and then press

until Ready appears.

Note: Power Saver settings can also be adjusted by typing the printer IP address into the address field of your Web
browser.

Minimizing your printer's environmental impact

36

Recycling
Lexmark provides collection programs and environmentally progressive approaches to recycling. For more information,
see:

• The Notices chapter
• The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment
• The Lexmark recycling program at www.lexmark.com/recycle

Recycling Lexmark products
To return Lexmark products for recycling:

1 Go to www.lexmark.com/recycle.
2 Find the product type you want to recycle, and then select your country or region from the list.
3 Follow the instructions on the computer screen.
Note: Printer supplies and hardware not listed in the Lexmark collection program may be recycled through your local
recycling center. Contact your local recycling center to determine the items they accept.

Recycling Lexmark packaging
Lexmark continually strives to minimize packaging. Less packaging helps to ensure that Lexmark printers are transported
in the most efficient and environmentally sensitive manner and that there is less packaging to dispose of. These
efficiencies result in fewer greenhouse emissions, energy savings, and natural resource savings.
Lexmark cartons are 100% recyclable where corrugated recycling facilities exist. Facilities may not exist in your area.
The foam used in Lexmark packaging is recyclable where foam recycling facilities exist. Facilities may not exist in your
area.
When you return a cartridge to Lexmark, you can reuse the box that the cartridge came in. Lexmark will recycle the
box.

Returning Lexmark cartridges for reuse or recycling
Lexmark Cartridge Collection Program diverts millions of Lexmark cartridges from landfills annually by making it both
easy and free for Lexmark customers to return used cartridges to Lexmark for reuse or recycling. One hundred percent
of the empty cartridges returned to Lexmark are either reused or demanufactured for recycling. Boxes used to return
the cartridges are also recycled.
To return Lexmark cartridges for reuse or recycling, follow the instructions that came with your printer or cartridge and
use the prepaid shipping label. You can also do the following:

1 Go to www.lexmark.com/recycle.
2 From the Toner Cartridges section, select your country or region.
3 Follow the instructions on the computer screen.
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Loading paper and specialty media
This section explains how to use the 250-sheet tray, the manual feeder, an optional 550-sheet tray and the 650-sheet
duo drawer with an integrated multipurpose feeder. It also includes information about paper orientation, setting the
Paper Size and Paper Type, and linking and unlinking trays.

Linking and unlinking trays
Linking trays
Tray linking is useful for large print jobs or multiple copies. When one linked tray is empty, paper feeds from the next
linked tray. When the Paper Size and Paper Type settings are the same for any trays, the trays are automatically linked.
The Paper Size setting for all trays must be set manually from the Paper Size menu. The Paper Type setting must be set
for all trays from the Paper Type menu. The Paper Type menu and the Paper Size menu are both available from the
Paper Size/Type menu.

Unlinking trays
Unlinked trays have settings that are not the same as the settings of any other tray.
To unlink a tray, change the following tray settings so that they do not match the settings of any other tray:

• Paper Type (for example: Plain Paper, Letterhead, Custom Type <x>)
Paper Type names describe the paper characteristics. If the name that best describes your paper is used by linked
trays, assign a different Paper Type name to the tray, such as Custom Type <x>, or define your own custom name.

• Paper Size (for example: letter, A4, statement)
Load a different paper size to change the Paper Size setting for a tray. Paper Size settings are not automatic; they
must be set manually from the Paper Size menu.
Warning—Potential Damage: Do not assign a Paper Type name that does not accurately describe the type of paper
loaded in the tray. The temperature of the fuser varies according to the specified Paper Type. Paper may not be
properly processed if an inaccurate Paper Type is selected.

Assigning a custom paper type name to a tray
Assign a Custom Type <x> name to a tray to link or unlink it. Associate the same Custom Type <x> name to each tray
that you want to link.

1 Make sure the printer is on and Ready appears.
2 From the printer control panel, press

.

3 Press the arrow buttons until Paper Menu appears, and then press
4 Press the arrow buttons until Size/Type appears, and then press
5 Press the arrow buttons, and then press

to select the tray.

The Paper Size menu appears.

6 Press the arrow buttons until the Paper Type menu appears.

.
.
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.

8 Press the arrow buttons until Custom Type <x> or another custom name appears, and then press

.

Submitting changes appears, followed by Paper Menu.

9 Press

, and then press

to return to the Ready state.

Setting the paper size and type
1 Make sure that the printer is on and Ready appears.
2 From the printer control panel, press

.

3 Press the arrow buttons until Paper Menu appears, and then press
4 Press the arrow buttons until Size/Type appears, and then press

.
.

5 Press the arrow buttons until the correct tray appears, and then press
6 Press

.

when Size appears.

7 Press the arrow buttons until the correct size appears, and then press

.

Submitting changes appears, followed by Size.

8 Press the arrow buttons until Type appears, and then press

.

9 Press the arrow buttons until the correct type appears, and then press

.

Submitting changes appears, followed by Type.

Configuring Universal paper settings
The Universal Paper Size is a user‑defined setting that lets you print on paper sizes that are not preset in the printer
menus. Set the Paper Size for the specified tray to Universal when the size you want is not available from the Paper
Size menu. Then, specify all of the following Universal size settings for your paper:

• Units of Measure (inches or millimeters)
• Portrait Height and Portrait Width
• Feed Direction
Note: The smallest supported Universal size is 76 x 127 mm (3 x 5 in.); the largest is 216 x 356 mm (8.5 x 14 in.).

Specify a unit of measure
1 Make sure the printer is on and Ready appears.
2 From the printer control panel, press

.

3 Press the arrow buttons until Paper Menu appears, and then press

.

4 Press the arrow buttons until Universal Setup appears, and then press
5 Press the arrow buttons until Units of Measure appears, and then press

.
.
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6 Press the arrow buttons until the correct unit of measure appears, and then press

.

Submitting changes appears, followed by the Universal Setup menu.

7 Press

, and then press

to return to the Ready state.

Specify the paper height and width
Defining a specific height and width measurement for the Universal paper size (in the portrait orientation) allows the
printer to support the size, including support for standard features such as duplex printing and printing multiple pages
on one sheet.

1 From the Universal Setup menu, press the arrow buttons until Portrait Width or Portrait Height
appears, and then press

.

Note: Select Portrait Height to adjust the paper height setting or Paper Width to adjust the paper
width setting.

2 Press the arrow buttons to decrease or increase the setting, and then press

.

Submitting changes appears, followed by the Universal Setup menu.

3 Press

, and then press

to return to the Ready state.

Loading the standard 250‑sheet tray
The printer has one standard 250‑sheet tray (Tray 1) with an attached manual feeder. The 250‑sheet tray, the 650‑sheet
duo drawer, and the optional 550‑sheet tray support the same paper sizes and types and are loaded in the same way.
Note: The optional 550‑sheet tray is not available for all printer models.

1 Pull the tray out.
Note: Do not remove trays while a job prints or while Busy appears on the display. Doing so may cause a jam.
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2 Squeeze the length guide tab inward as shown, and slide the guide to the correct position for the paper size being
loaded.

Note: Use the size indicators on the bottom of the tray to help position the guide.

3 If the paper is longer than A4 or letter size, push the green tab at the back of the tray to extend it.

4 Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten the
edges on a level surface.

5 Load the paper stack with the recommended print side faceup.
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6 Make sure the paper guides are secure against the edges of the paper.
Note: Make sure that side guides are placed tightly against the edges of the paper so that the image is
registered properly on the page.

7 Insert the tray.

8 If a different type or size of paper was loaded than the type or size previously loaded in the tray, change the Paper
Type or Paper Size setting for the tray from the printer control panel.
Note: Mixing paper sizes or types in a tray may lead to jams.

Loading the 650‑sheet duo drawer
The 650‑sheet duo drawer (Tray 2) consists of a 550‑sheet tray and an integrated 100‑sheet multipurpose feeder. The
drawer is loaded in the same way as the 250‑sheet tray and the optional 550‑sheet tray, and supports the same paper
types and sizes. The only differences are the look of the guide tabs and the location of the paper size indicators, as
shown in the following illustration:
Note: The optional 550‑sheet tray is not available for all printer models.
1
2

3

1

Length guide tabs

2

Size indicators

3

Width guide tabs
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Using the multipurpose feeder
1 Push the feeder release latch to the left to open the multipurpose feeder.

2 Grasp the extension, and pull it straight out until it is fully extended.

3 Prepare the paper for loading.
• Flex sheets of paper back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten
the edges on a level surface.

• Hold transparencies by the edges and fan them. Straighten the edges on a level surface.
Note: Avoid touching the print side of transparencies. Be careful not to scratch them.

• Flex a stack of envelopes back and forth to loosen them, and then fan them. Straighten the edges on a level
surface.

4 Locate the stack height limiter and tab.
Note: Do not exceed the maximum stack height by forcing paper under the stack height limiter.
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1

2

4
3

1

Tab

2

Stack height limiter

3

Width guides

4

Size indicators

5 Load the paper, and then adjust the width guide to lightly touch the edge of the paper stack.
• Load paper, card stock, and transparencies with the recommended print side facedown and the top edge
entering first.

• Load envelopes with the flap side up.
Warning—Potential Damage: Never use envelopes with stamps, clasps, snaps, windows, coated linings, or
self‑stick adhesives. These envelopes may severely damage the printer.
Notes:

• Do not load or close the multipurpose feeder while a job is printing.
• Load only one size and type of paper at a time.
6 Make sure the paper is as far into the multipurpose feeder as it will go with very gentle pushing. Paper should lie
flat in the multipurpose feeder. Make sure the paper fits loosely in the multipurpose feeder and is not bent or
wrinkled.
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Using the manual feeder
The standard 250‑sheet tray has an integrated manual feeder that can be used to print on different types of paper one
sheet at a time.

1 Load a sheet of paper into the manual feeder.
• Printable side facedown for one-sided printing.
• Printable side faceup for two‑sided (duplex) printing.
Note: There are different ways for loading letterhead depending on the mode of printing.
One‑sided printing using a letterhead Two‑sided printing using a letter‑head

• Load envelopes with the flap side up and against the right side of the paper guide.

2 Feed paper into the manual feeder only to the point where its leading edge can contact the paper guides.
Note: To achieve the best possible print quality, use only high‑quality media designed for laser printers.

3 Adjust the paper guides to the paper width.
Warning—Potential Damage: Do not force the paper into the feeder. Forcing the paper causes jams.
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Paper and specialty media guidelines
Additional information for printing on speciality medias may be found in the Cardstock and Label Guide available at
http://support.lexmark.com.

Paper guidelines
Paper characteristics
The following paper characteristics affect print quality and reliability. Consider these characteristics when evaluating
new paper stock.

Weight
The printer can automatically feed paper weights from 60 to 176 g/m2 (16 to 47 lb bond) grain long. Paper lighter than
75 g/m2 (20 lb) might not be stiff enough to feed properly, causing jams. For best performance, use 80 g/m2 (21 lb
bond) grain long paper. For paper smaller than 182 x 257 mm (7.2 x 10.1 in.), we recommend 90 g/m2 or heavier paper.

Curl
Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can occur after
the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped in hot, humid,
cold, or dry conditions, even in the trays, can contribute to paper curling prior to printing and can cause feeding
problems.

Smoothness
Paper smoothness directly affects print quality. If paper is too rough, toner cannot fuse to it properly. If paper is too
smooth, it can cause paper feeding or print quality issues. Always use paper between 100 and 300 Sheffield points;
however, smoothness between 150 and 200 Sheffield points produces the best print quality.

Moisture content
The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper correctly.
Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to moisture changes that
can degrade its performance.
Condition paper before printing by storing it in its original wrapper in the same environment as the printer for 24 to
48 hours before printing. Extend the time several days if the storage or transportation environment is very different
from the printer environment. Thick paper may also require a longer conditioning period.

Grain direction
Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of
the paper, or grain short, running the width of the paper.
For 60 to 176 g/m2 (16 to 47 lb bond) paper, use grain long fibers.

Paper and specialty media guidelines

47

Fiber content
Most high‑quality xerographic paper is made from 100% chemically treated pulped wood. This content provides the
paper with a high degree of stability resulting in fewer paper feeding problems and better print quality. Paper containing
fibers such as cotton possesses characteristics that can negatively affect paper handling.

Selecting paper
Using appropriate paper prevents jams and helps ensure trouble‑free printing.
To help avoid jams and poor print quality:

• Always use new, undamaged paper.
• Before loading paper, know the recommended print side of the paper. This information is usually indicated on the
paper package.

• Do not use paper that has been cut or trimmed by hand.
• Do not mix paper sizes, types, or weights in the same source; mixing results in jams.
• Do not use coated papers unless they are specifically designed for electrophotographic printing.

Selecting preprinted forms and letterhead
Use these guidelines when selecting preprinted forms and letterhead:

• Use grain long for 60 to 176 g/m2 weight paper.
• Use only forms and letterhead printed using an offset lithographic or engraved printing process.
• Avoid papers with rough or heavily textured surfaces.
Use papers printed with heat‑resistant inks designed for use in xerographic copiers. The ink must be able to withstand
temperatures up to 200°C (392°F) without melting or releasing hazardous emissions. Use inks that are not affected by
the resin in toner. Inks that are oxidation‑set or oil‑based generally meet these requirements; latex inks might not.
When in doubt, contact the paper supplier.
Preprinted papers such as letterhead must be able to withstand temperatures up to 200°C (392°F) without melting or
releasing hazardous emissions.

Storing paper
Use these paper storage guidelines to help avoid jams and uneven print quality:

• For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40%. Most label
manufacturers recommend printing in a temperature range of 18 to 24°C (65 to 75°F) with relative humidity between
40 and 60%.

• Store paper in cartons when possible, on a pallet or shelf, rather than on the floor.
• Store individual packages on a flat surface.
• Do not store anything on top of individual paper packages.
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Supported paper sizes, types, and weights
The following tables provide information on standard and optional input sources and the sizes, types, and weights of
print media they support.
Note: For an unlisted paper size, select the closest larger listed size.

Paper sizes supported by the printer
Notes:

• Your printer model may have a 650‑sheet duo drawer, which consists of a 550‑sheet tray and an integrated
100‑sheet multipurpose feeder. The 550‑sheet tray part of the 650‑sheet duo drawer supports the same paper
as the optional 550‑sheet tray. The integrated multipurpose feeder supports different paper sizes, types, and
weights.

• The optional 550‑sheet tray is not available for all printer models.
Paper size

Dimensions

250‑sheet tray Optional
550‑sheet tray

A4

210 x 297 mm
(8.3 x 11.7 in.)

A5

148 x 210 mm
(5.83 x 8.3 in.)

JIS B5

182 x 257 mm
(7.2 x 10.1 in.)

A6

105 x 148 mm
(4.1 x 5.8 in.)

X

X

Statement

140 x 216 mm
(5.5 x 8.5 in.)

X

X

Letter

216 x 279 mm
(8.5 x 11 in.)

Folio

216 x 330 mm
(8.5 x 13 in.)

Oficio (Mexico)

216 x 340 mm
(8.5 x 13 in.)

Legal

216 x 356 mm
(8.5 x 14 in.)

Executive

184 x 267 mm
(7.3 x 10.5 in.)

Multipurpose
feeder

Manual
feeder

* When Universal is selected, the page is formatted for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software

program.
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250‑sheet tray Optional
550‑sheet tray

76 x 127 mm (3 x 5 in.) X
up to 216 x 356 mm
(8.5 x 14 in.)

X

7 3/4 Envelope
(Monarch)

98 x 191 mm
(3.9 x 7.5 in.)

X

X

9 Envelope

98 x 225 mm
(3.9 x 8.9 in.)

X

X

10 Envelope

105 x 241 mm
(4.1 x 9.5 in.)

X

X

DL Envelope

110 x 220 mm
(4.3 x 8.7 in.)

X

X

B5 Envelope

176 x 250 mm
(6.9 x 9.8 in.)

X

X

C5 Envelope

162 x 229 mm
(6.4 x 9 in.)

X

X

Monarch

105 x 241 mm
(4.1 x 9.5 in.)

X

X

Other Envelope

98 x 162 mm
(3.9 x 6.3 in.) up to
176 x 250 mm
(6.9 x 9.8 in.)

X

X

Multipurpose
feeder

Manual
feeder

* When Universal is selected, the page is formatted for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software

program.

Paper types supported by the printer
Notes:

• Your printer model may have a 650‑sheet duo drawer, which consists of a 550‑sheet tray and an integrated
100‑sheet multipurpose feeder. The 550‑sheet tray part of the 650‑sheet duo drawer supports the same paper
as the optional 550‑sheet tray. The integrated multipurpose feeder supports different paper sizes, types, and
weights.

• The optional 550‑sheet tray is not available for all printer models.
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Standard 250‑sheet
tray

Optional 550‑sheet
tray

Multipurpose feeder Manual feeder

Paper
Card stock
Transparencies*
Envelopes

X
X

X

Paper labels
* Lexmark transparency part numbers 12A8240 and 12A8241 are supported from the standard tray, the manual feeder,
and the multipurpose feeder.

Paper types and weights supported by the printer
Notes:

• Your printer model may have a 650‑sheet duo drawer, which consists of a 550‑sheet tray and an integrated
100‑sheet multipurpose feeder. The 550‑sheet tray part of the 650‑sheet duo drawer supports the same paper
as the optional 550‑sheet tray. The integrated multipurpose feeder supports different paper sizes, types, and
weights.

• The optional 550‑sheet tray is not available for all printer models.
Paper type

250‑sheet tray

Optional 550‑sheet
tray

Multipurpose feeder

Manual feeder

Light1, 2

60 to 74.9 g/m2 grain
long (16 to 19.9 lb
bond)

60 to 74.9 g/m2 grain
long (16 to 19.9 lb
bond)

60 to 74.9 g/m2 grain
long (16 to 19.9 lb
bond)

60 to 74.9 g/m2 grain
long (16 to 19.9 lb
bond)

Plain1, 2

75 to 89.9 g/m2 grain
long (20 to 23.8 lb
bond)

75 to 89.9 g/m2 grain
long (20 to 23.8 lb
bond)

75 to 89.9 g/m2 grain
long (20 to 23.8 lb
bond)

75 to 89.9 g/m2 grain
long (20 to 23.8 lb
bond)

Heavy1, 2

90 to 104.9 g/m2 grain 90 to 104.9 g/m2 grain 90 to 104.9 g/m2 grain 90 to 104.9 g/m2 grain
long (23.9 to 27.8 lb
long (23.9 to 27.8 lb
long (23.9 to 27.8 lb
long (23.9 to 27.8 lb
bond)
bond)
bond)
bond)

1

Paper types must be set to match the supporting paper weights.

2

The duplex supports paper weights between 60–105 g/m2 (16–28 lb) grain long bond. The duplex does not support card
stock, transparencies, envelopes, or labels.
3

For 60 to 176 g/m2 (16 to 47 lb bond) paper, we recommend grain long fibers.

4

Lexmark transparency part numbers 12A8240 and 12A8241 are supported from the 250‑sheet tray, manual feeder, and
multipurpose feeder.
5

The pressure sensitive area must enter the printer first.

6

100 percent cotton content maximum weight is 90 g/m2 (24 lb) bond.

7

105 g/m2 (28 lb) bond envelopes are limited to 25 percent cotton content.
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Paper type

250‑sheet tray

Optional 550‑sheet
tray

Multipurpose feeder

Manual feeder

Cardstock1, 2

105 to 176 g/m2 grain 105 to 176 g/m2 grain
long (27.8 to 47 lb
long (27.8 to 47 lb
bond)
bond)

Glossy papers

Book—88 to 176 g/m2 Book—88 to 176 g/m2 Book—88 to 176 g/m2 Book—88 to 176 g/m2
grain long (60 to 120 lb grain long (60 to 120 lb grain long (60 to 120 lb grain long (60 to 120 lb
book)
book)
book)
book)

105 to 176 g/m2 grain 105 to 176 g/m2 grain
long (27.8 to 47 lb
long (27.8 to 47 lb
bond)
bond)

Cover—162 to
Cover—162 to
Cover—162 to
Cover—162 to
176 g/m2 grain long (60 176 g/m2 grain long (60 176 g/m2 grain long (60 176 g/m2 grain long (60
to 65 lb cover)
to 65 lb cover)
to 65 lb cover)
to 65 lb cover)
Card stock—maximum Index Bristol—
(grain long)3
120 g/m2 (67 lb)

Index Bristol—
120 g/m2 (67 lb)

Index Bristol—
120 g/m2 (67 lb)

Index Bristol—
120 g/m2 (67 lb)

Tag—120 g/m2 (74 lb) Tag—120 g/m2 (74 lb)

Tag—120 g/m2 (74 lb) Tag—120 g/m2 (74 lb)

Cover—135 g/m2
(50 lb)

Cover—135 g/m2
(50 lb)

Cover—135 g/m2
(50 lb)

Cover—135 g/m2
(50 lb)

Index Bristol—
163 g/m2 (90 lb)

Index Bristol—
163 g/m2 (90 lb)

Index Bristol—
163 g/m2 (90 lb)

Card stock—maximum Index Bristol—
(grain short)1
163 g/m2 (90 lb)

Tag—163 g/m2 (100 lb) Tag—163 g/m2 (100 lb) Tag—163 g/m2 (100 lb) Tag—163 g/m2 (100 lb)
Cover—176 g/m2
(65 lb)

Cover—176 g/m2
(65 lb)

Cover—176 g/m2
(65 lb)

Cover—176 g/m2
(65 lb)

Transparencies4

170–180 g/m2 (45 to
48 lb)

N/A

170–180 g/m2 (45 to
48 lb)

170–180 g/m2 (45 to
48 lb)

Labels—maximum5

Paper—131 g/m2
(35 lb bond)

Paper—131 g/m2 (35 lb Paper—131 g/m2
bond)
(35 lb bond)

Envelopes6,7

X

X

1

60 to 105 g/m2 (16 to
28 lb bond)

Paper—131 g/m2
(35 lb bond)
60 to 105 g/m2 (16 to
28 lb bond)

Paper types must be set to match the supporting paper weights.

2

The duplex supports paper weights between 60–105 g/m2 (16–28 lb) grain long bond. The duplex does not support card
stock, transparencies, envelopes, or labels.
3

For 60 to 176 g/m2 (16 to 47 lb bond) paper, we recommend grain long fibers.

4

Lexmark transparency part numbers 12A8240 and 12A8241 are supported from the 250‑sheet tray, manual feeder, and
multipurpose feeder.
5

The pressure sensitive area must enter the printer first.

6

100 percent cotton content maximum weight is 90 g/m2 (24 lb) bond.

7

105 g/m2 (28 lb) bond envelopes are limited to 25 percent cotton content.
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Paper capacities
Input capacities
Notes:

• Your printer model may have a 650‑sheet duo drawer, which consists of a 550‑sheet tray and an integrated
100‑sheet multipurpose feeder. The 550‑sheet tray part of the 650‑sheet duo drawer supports the same paper
as the optional 550‑sheet tray. The integrated multipurpose feeder supports different paper sizes, types, and
weights.

• The optional 550‑sheet tray is not available for all printer models.
Paper type

250‑sheet tray

Optional 550‑sheet tray

Multipurpose tray

Paper

250 sheets1

550 sheets1

100 sheets1

Labels

1002

2002

502

Transparencies

50

X

50

Envelopes

X

X

10

Other

X

X

Various quantities3

1

Based on 75 g/m2 (20 lb) paper

2

Capacity varies depending on label material and construction.

3

Capacity varies depending on the weight and type of paper.

Output capacity
Paper type

Standard output bin1

Paper

100 sheets2

1

Capacity may vary depending on media specifications and the printer operating environment.

2

Based on 75 g/m2 (20 lb) paper

Printing
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Printing
Printing a document
Printing a document
1 From the printer control panel, set the paper type and size to match the paper loaded.
2 Send the print job:
For Windows users
a With a document open, click File > Print.
b Click Properties, Preferences, Options, or Setup.
c Adjust the settings, if necessary.
d Click OK > Print.
For Macintosh users
a Customize the settings in the Page Setup dialog:
1 With a document open, choose File > Page Setup.
2 Choose a paper size or create a custom size to match the paper loaded.
3 Click OK.
b Customize the settings in the Print dialog:
1 With a document open, choose File > Print.
If necessary, click the disclosure triangle to see more options.
2 From the print options pop‑up menus, adjust the settings, if necessary.
Note: To print on a specific paper type, adjust the paper type setting to match the paper loaded, or
select the appropriate tray or feeder.
3 Click Print.

Printing specialty documents
Additional information for printing on speciality medias may be found in the Cardstock and Label Guide available on
http://support.lexmark.com.

Tips on using letterhead
Page orientation is important when printing on letterhead. Use the following table to determine which direction to
load the letterhead:

Printing

Source or process

• Standard 250‑sheet tray
• Optional 550‑sheet tray
• Simplex (one‑sided) printing

54

Print side and paper orientation
Printed letterhead design is placed faceup. The top edge of the sheet with the logo is
placed at the front of the tray.

from trays

Duplex (two‑sided) printing from
trays

Printed letterhead design is placed facedown. The top edge of the sheet with the logo
is placed at the back of the tray.

Manual feeder (simplex printing)

Preprinted letterhead design is placed facedown. The top edge of the sheet with the
logo should enter the manual feeder first.

Multipurpose feeder

Note: Check with the manufacturer or vendor to determine whether the chosen preprinted letterhead is acceptable for
laser printers.

Printing
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Source or process

Print side and paper orientation

Manual feeder (duplex printing)

Preprinted letterhead design is placed faceup. The top edge of the sheet with the logo
should enter the manual feeder last.

Multipurpose feeder

Note: Check with the manufacturer or vendor to determine whether the chosen preprinted letterhead is acceptable for
laser printers.

Tips on using transparencies
Print samples on the transparencies being considered for use before buying large quantities.
When printing on transparencies:

• Feed transparencies from the standard 250‑sheet tray or the manual feeder.
• Use transparencies designed specifically for laser printers. Check with the manufacturer or vendor to ensure that
the transparencies are able to withstand temperatures up to 175° C (350° F) without melting, discoloring, offsetting,
or releasing hazardous emissions.
Note: Transparencies can be printed at a temperature up to 180° C (356° F) if Transparency Weight is set to
Heavy and Transparency Texture is set to Rough. Select these settings in the Paper menu using a local utility.

• To prevent print quality problems, avoid getting fingerprints on the transparencies.
• Before loading transparencies, fan the stack to prevent sheets from sticking together.
• We recommend Lexmark part number 70X7240 for letter‑size transparencies and Lexmark part number 12A5010
for A4‑size transparencies.

Tips on using envelopes
Print samples on the envelopes being considered for use before buying large quantities.
When printing on envelopes:

• Feed envelopes from the manual feeder or optional multipurpose feeder.
• Set the Paper Type to Envelope, and select the envelope size.
• Use envelopes designed specifically for laser printers. Check with the manufacturer or vendor to ensure the
envelopes can withstand temperatures up to 200°C (392°F) without sealing, wrinkling, curling excessively, or
releasing hazardous emissions.

• For the best performance, use envelopes made from 60 g/m2 (16 lb bond) paper. Use up to 105 g/m2 (28 lb bond)
weight for envelopes as long as the cotton content is 25% or less. All‑cotton envelopes must not exceed 90 g/m2
(24 lb bond) weight.

Printing
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• Use only new envelopes.
• To optimize performance and minimize jams, do not use envelopes that:
– Have excessive curl or twist
– Are stuck together or damaged in any way
– Have windows, holes, perforations, cutouts, or embossing
– Have metal clasps, string ties, or folding bars
– Have an interlocking design
– Have postage stamps attached
– Have any exposed adhesive when the flap is in the sealed or closed position
– Have bent corners
– Have rough, cockle, or laid finishes
• Adjust the width guides to fit the width of the envelopes.
Note: A combination of high humidity (over 60%) and the high printing temperature may wrinkle or seal envelopes.

Tips on using labels
Print samples on the labels being considered for use before buying large quantities.
Note: Use only paper label sheets. Vinyl, pharmacy, and dual‑sided labels are not supported.
For detailed information on label printing, characteristics, and design, see the Card Stock & Label Guide available on
the Lexmark Web site at http://support.lexmark.com.
When printing on labels:

• Use labels designed specifically for laser printers. Check with the manufacturer or vendor to verify that:
– The labels can withstand temperatures up to 210°C (410°F) without sealing, excessive curling, wrinkling, or
releasing hazardous emissions.
Note: Labels can be printed at a higher fusing temperature up to 220°C (428°F) if Label Weight is set to
Heavy. Select this setting using the Embedded Web Server, or from the printer control panel Paper menu.

– Label adhesives, face sheet (printable stock), and topcoats can withstand up to 25‑psi (172‑kPa) pressure without
delaminating, oozing around the edges, or releasing hazardous fumes.

• Do not use labels with slick backing material.
• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets
also contaminate the printer and the cartridge with adhesive, and could void the printer and cartridge warranties.

• Do not use labels with exposed adhesive.
• Do not print within 1 mm (0.04 in.) of the edge of the label, of the perforations, or between die‑cuts of the label.
• Be sure adhesive backing does not reach to the sheet edge. Zone coating of the adhesive at least 1 mm (0.04 in.)
away from edges is recommended. Adhesive material contaminates the printer and could void the warranty.

• If zone coating of the adhesive is not possible, remove a 2‑mm (0.06‑in.) strip on the leading and driver edge, and
use a non‑oozing adhesive.

• Portrait orientation works best, especially when printing bar codes.

Printing
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Tips on using card stock
Card stock is heavy, single‑ply specialty media. Many of its variable characteristics, such as moisture content, thickness,
and texture, can significantly impact print quality. Print samples on the card stock being considered for use before
buying large quantities.
When printing on card stock:

• From MarkVision Professional, the printer software, or the printer control panel:
1 Set the Paper Type to Card Stock.
2 Set the Paper Weight to Card Stock Weight.
3 Set the Card Stock Weight to Normal or Heavy.
• Be aware that preprinting, perforation, and creasing may significantly affect the print quality and cause jams or
other paper handling problems.

• Check with the manufacturer or vendor to ensure the card stock can withstand temperatures up to 200°C (392°F)
without releasing hazardous emissions.

• Do not use preprinted card stock manufactured with chemicals that may contaminate the printer. Preprinting
introduces semi‑liquid and volatile components into the printer.

• Use grain short card stock when possible.

Printing
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Printing from a flash drive
A USB port is located on the printer control panel of some models. Insert a flash drive to print supported file types.
Supported file types include: .pdf, .gif, .jpeg, .jpg, .bmp, .png, .tiff, .tif, .pcx, and .dcx.
Many flash drives are tested and approved for use with the printer. For more information, visit the Lexmark Web site
at www.lexmark.com.
Notes:

• Hi‑Speed USB devices must support the Full‑speed standard. Devices only supporting USB Low‑speed
capabilities are not supported.

• USB devices must support the FAT (File Allocation Tables) system. Devices formatted with NTFS (New
Technology File System) or any other file system are not supported.

• Before printing an encrypted .pdf file, enter the file password from the printer control panel.
• You cannot print files for which you do not have printing permissions.
1 Make sure the printer is on and Ready or Busy appears.
2 Insert a flash drive into the USB port.

Note: If you insert the flash drive when the printer requires attention, such as when a jam has occurred, the
printer ignores the memory device.

3 Press the arrow buttons until the document you want to print appears, and then press

.

Note: Folders found on the flash drive appear as folders. File names are appended by the extension type (for
example, .jpg).

4 Press

to print one copy, or enter the number of copies using the arrow buttons, and then press
the print job.
Note: Do not remove the flash drive from the USB port until the document has finished printing.

to initiate

Printing
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Printing photos from a PictBridge‑enabled digital camera
1 Insert one end of the USB cable into the camera.
Note: Use only the USB cable that came with your camera.

2 Insert the other end of the USB cable into the USB port on the front of the printer.

Notes:

• Make sure the PictBridge‑enabled digital camera is set to the correct USB mode. For more information, see
the camera documentation.

• If the PictBridge connection is successful, then a confirmation message appears on the printer display.
3 Follow the instructions on the camera to select and print photos.
Note: If the printer is turned off while the camera is connected, then you must disconnect and then reconnect the
camera.

Printing information pages
Printing a font sample list
1 Make sure the printer is on and Ready appears.
2 From the printer control panel, press

.

3 Press the arrow buttons until Reports appears, and then press

.

4 Press the arrow buttons until Print Fonts appears, and then press

.

5 Press the arrow buttons until PCL Fonts or PostScript Fonts appears, and then press
After the font sample list prints, Ready appears.

.

Printing
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Printing a directory list
A directory list shows the resources stored in flash memory.

1 Make sure the printer is on and Ready appears.
2 From the printer control panel, press

.

3 Press the arrow buttons until Reports appears, and then press

.

4 Press the arrow buttons until Print Directory appears, and then press

.

After the directory list prints, Ready appears.

Printing the print quality test pages
Print the print quality test pages to isolate print quality problems.

1 Turn the printer off.
2 Hold down

and

while turning the printer on.

3 Release the buttons when the dots appear, and then wait for Config Menu to appear.
4 Press the arrow buttons until Prt Quality Pgs appears, and then press

.

The print quality test pages print.

5 Press the arrow buttons until Exit Config Menu appears, and then press
Ready appears.

Canceling a print job
Canceling a print job from the printer control panel
1 Press

.

Stopping appears, followed by Cancel Print Job.

2 Press

.

Canceling appears, followed by Ready.

Canceling a print job from the computer
For Windows users
1 Open the printers folder.
In Windows 8
From the Search charm, type run, and then navigate to:
Apps list > Run > type control printers > OK

.

Printing

In Windows 7 or earlier

a Click
or click Start, and then click Run.
b In the Start Search or Run dialog, type control printers.
c Press Enter, or click OK.
2 Double‑click the printer icon.
3 Select the print job you want to cancel.
4 Click Delete.

For Macintosh users
1 From the Apple menu, navigate to either of the following:
• System Preferences > Print & Scan > select your printer > Open Print Queue
• System Preferences > Print & Fax > select your printer > Open Print Queue
2 From the printer window, select the print job you want to cancel, and then delete it.
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Understanding printer menus
Menus list
Supplies Menu

Paper Menu

Reports

Network/Ports

Settings

Cyan Cartridge
Magenta Cartridge

Default Source
Size/Type

Menu Settings Page
Device Statistics

Active NIC
Network Menu

General Settings
Setup Menu

Yellow Cartridge

Paper Texture

Network Setup Page

USB Menu

Finishing Menu

Black Cartridge

Paper Weight

Print Fonts

Wireless Menu

Quality Menu

Imaging Kit

Paper Loading

Print Defects

Utilities Menu

Waste Toner Box

Custom Types

Asset Report

PDF Menu

Universal Setup

PostScript Menu
PCL Emul Menu
Image Menu
PictBridge Menu
Flash Drive Menu

Note: Certain menus are not available on selected printer models.

Supplies menu
Menu item

Description

Cyan, Magenta, Yellow, or Black Toner Cartridges
Early Warning
Low
Invalid
Replace
Missing or Defective
OK
Unsupported

Shows the status of the toner cartridges
Note: Replace Cartridge indicates the cartridge is
nearly empty, and print quality problems may result.

Imaging Kit
OK
Replace Black Imaging Kit
Replace Color Imaging Kit
Defective

Shows the status of the imaging kit

Waste Toner Box
Near Full
Replace
Missing
OK

Shows the status of the waste toner box
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Paper menu
Default Source menu
Menu item

Description

Default Source
Tray <x>
MP Feeder
Manual Paper
Manual Env

Sets a default paper source for all print jobs
Notes:

• Tray 1 (standard tray) is the factory default setting.
• The 650‑sheet duo drawer must be installed in order for MP Feeder or
Tray 2 to appear as a menu setting in the Paper menu.

• Only an installed paper source will appear as a menu setting.
• A paper source selected by a print job will override the Default Source
setting for the duration of the print job.

• If the same size and type of paper are in two trays and the Paper Size and
Paper Type settings match, the trays are automatically linked. When one
tray is empty, the job prints using the linked tray.

Paper Size/Type menu
Menu item

Description

Tray <x> Size
A4
A5
JIS B5
Letter
Folio
Oficio (Mexico)
Legal
Executive
Universal

Specifies the paper size loaded in each tray
Notes:

• Letter is the US factory default setting. A4 is the international factory
default setting.

• If the same size and type of paper are in two trays and the Paper Size
and Paper Type settings match, the trays are automatically linked.
When one tray is empty, the job prints using the linked tray.

Note: Only installed trays, drawers, and feeders are listed in this menu.
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Menu item

Description

Tray <x> Type
Plain Paper
Glossy Paper
Card Stock
Transparency
Recycled
Letterhead
Colored Paper
Labels
Bond
Preprinted
Light Paper
Heavy Paper
Rough/Cotton
Custom Type <x>

Specifies the type of paper loaded in each tray

MP Feeder Size
A4
A5
JIS B5
A6
Statement
Letter
Folio
Oficio (Mexico)
Legal
Executive
Universal
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
B5 Envelope
C5 Envelope
Other Envelope

Specifies the paper size loaded in the multipurpose feeder

Notes:

• Plain Paper is the factory default setting for Tray 1. Custom Type <x> is
the factory default setting for all other trays.

• If available, a user‑defined name will appear instead of Custom
Type <x>.

• Use this menu item to configure automatic tray linking.

Notes:

• The 650‑sheet duo drawer must be installed in order for MP Feeder to
appear as a menu setting in the Paper menu.

• Letter is the US factory default setting. A4 is the international factory
default setting.

• The multipurpose feeder does not automatically sense paper size. The
paper size value must be set.

Note: Only installed trays, drawers, and feeders are listed in this menu.
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Menu item

Description

MP Feeder Type
Plain Paper
Glossy Paper
Card Stock
Transparency
Recycled
Letterhead
Colored Paper
Labels
Bond
Envelope
Preprinted
Light Paper
Heavy Paper
Rough/Cotton
Custom Type <x>

Specifies the type of paper loaded in the multipurpose feeder

Manual Paper Size
A4
A5
JIS B5
A6
Statement
Letter
Folio
Oficio (Mexico)
Legal
Executive
Universal

Specifies the size of the paper being manually loaded

Manual Paper Type
Plain Paper
Glossy Paper
Card Stock
Transparency
Recycled
Letterhead
Colored Paper
Labels
Bond
Preprinted
Light Paper
Heavy Paper
Rough/Cotton
Custom Type <x>

Specifies the type of paper being manually loaded

Notes:

• The 650‑sheet duo drawer must be installed in order for MP Feeder to
appear as a menu setting in the Paper menu.

• Plain paper is the factory default setting.

Note: Letter is the US factory default setting. A4 is the international factory
default setting.

Note: Plain Paper is the factory default setting.

Note: Only installed trays, drawers, and feeders are listed in this menu.
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Menu item

Description

Manual Envelope Size
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
B5 Envelope
C5 Envelope
Other Envelope

Specifies the size of the envelope being manually loaded

Manual Envelope Type
Envelope
Custom Type <x>

Specifies the type of envelope being manually loaded

Note: 10 Envelope is the US factory default setting. DL Envelope is the
international factory default setting.

Note: Envelope is the factory default setting.

Note: Only installed trays, drawers, and feeders are listed in this menu.

Paper Texture menu
Menu item

Description

Plain Texture
Normal
Smooth
Rough

Specifies the relative texture of the paper loaded

Card Stock Texture
Normal
Smooth
Rough

Specifies the relative texture of the card stock loaded

Transparency Texture
Normal
Smooth
Rough

Specifies the relative texture of the transparencies loaded

Recycled Texture
Normal
Smooth
Rough

Specifies the relative texture of the recycled paper loaded

Glossy Texture
Normal
Smooth
Rough

Specifies the relative texture of the glossy paper loaded

Labels Texture
Normal
Smooth
Rough

Specifies the relative texture of the labels loaded

Note: Normal is the factory default setting.

Notes:

• Normal is the factory default setting.
• Settings appear only if card stock is supported.
Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.
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Menu item

Description

Bond Texture
Rough
Smooth
Normal

Specifies the relative texture of the paper loaded

Envelope Texture
Normal
Smooth
Rough

Specifies the relative texture of the envelopes loaded

Letterhead Texture
Normal
Smooth
Rough

Specifies the relative texture of the paper loaded

Preprinted Texture
Normal
Smooth
Rough

Specifies the relative texture of the paper loaded

Colored Texture
Normal
Smooth
Rough

Specifies the relative texture of the colored paper loaded

Light Paper
Normal
Smooth
Rough

Specifies the relative texture of the light paper loaded

Heavy Paper
Normal
Smooth
Rough

Specifies the relative texture of the heavy paper loaded

Rough/Cotton Paper
Rough

Specifies the relative texture of the rough/cotton paper loaded

Note: Rough is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Notes:

• Normal is the factory default setting.
• Settings appear only if the custom type is supported.
Notes:

• Normal is the factory default setting.
• Settings appear only if the custom type is supported.
Notes:

• Rough is the factory default setting.
• Settings appear only if the custom type is supported.
Custom <x> Paper
Normal
Smooth
Rough

Specifies the relative texture of the custom paper loaded
Notes:

• Normal is the factory default setting.
• Settings appear only if the custom type is supported.
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Paper Weight menu
Menu items

Definition

Plain Weight, Glossy Weight, Bond Weight, Letterhead Weight,
Preprinted Weight, or Colored Weight
Normal
Light
Heavy

Identifies the relative weight of the paper loaded

Transparency Weight
Normal
Light
Heavy

Identifies the relative weight of the transparencies
loaded

Recycled Weight
Normal
Light
Heavy

Identifies the relative weight of the recycled paper
loaded

Labels Weight
Normal
Light
Heavy

Identifies the relative weight of the labels loaded

Envelope Weight
Normal
Light
Heavy

Identifies the relative weight of the envelopes
loaded

Card Stock Weight
Normal
Light
Heavy

Identifies the relative weight of the card stock
loaded

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Notes:

• Normal is the factory default setting.
• Settings appear only if card stock is
supported.

Light Paper Weight
Light

Identifies the relative weight of the light paper
loaded
Notes:

• Light is the factory default setting.
• Settings appear only if light paper is
supported.
Heavy Paper Weight
Heavy

Identifies the relative weight of the heavy paper
loaded
Notes:

• Heavy is the factory default setting.
• Settings appear only if heavy paper is
supported.
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Menu items

Definition

Rough/Cotton Paper Weight
Normal

Identifies the relative weight of the rough/cotton
paper loaded
Notes:

• Normal is the factory default setting.
• Settings appear only if rough/cotton paper is
supported.
Custom <x>
Normal
Light
Heavy

Identifies the relative weight of the custom paper
type loaded
Notes:

• Normal is the factory default setting.
• Settings appear only if custom paper is
supported.

Paper Loading menu
Note: Certain options are not available on select printer models.
Menu item

Description

Recycled Loading
Off
Duplex

Determines the paper loading direction for all jobs that specify
Recycled as the paper type

Glossy Loading
Off
Duplex

Determines the paper loading direction for all jobs that specify glossy
as the paper type

Bond Loading
Off
Duplex

Determines the paper loading direction for all jobs that specify Bond
as the paper type

Letterhead Loading
Off
Duplex

Determines the paper loading direction for all jobs that specify
Letterhead as the paper type

Preprinted Loading
Off
Duplex

Determines the paper loading direction for all jobs that specify
Preprinted as the paper type

Colored Loading
Off
Duplex

Determines the paper loading direction for all jobs that specify
Colored as the paper type

Light Paper Loading
Off
Duplex

Determines the paper loading direction for all jobs that specify Light
Paper as the paper type

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Duplex sets the printer default to 2‑sided printing for every print job unless 1‑sided printing is selected from Print
Properties (in Windows) or the Print dialog (in Macintosh).
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Menu item

Description

Heavy Paper Loading
Off
Duplex

Determines the paper loading direction for all jobs that specify Heavy
Paper as the paper type

Rough/Cotton Loading
Off
Duplex

Determines the paper loading direction for all jobs that specify
Rough/Cotton as the paper type

Custom <x> Loading
Off
Duplex

Determines the paper loading direction for all jobs that specify
Custom <x> as the paper type

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Notes:

• Off is the factory default setting.
• Custom <x> Loading is available only if the custom type is
supported.
Note: Duplex sets the printer default to 2‑sided printing for every print job unless 1‑sided printing is selected from Print
Properties (in Windows) or the Print dialog (in Macintosh).

Custom Types menu
Menu item

Description

Custom Type <x>
Paper
Card Stock
Transparency
Glossy
Labels
Envelope
Rough/Cotton

Associates a paper or specialty media type with a factory default Custom
Type <x> name or a user‑defined Custom Name created from the Embedded
Web Server or MarkVisionTM Professional. This user‑defined name displays
instead of Custom Type <x>.

Recycled
Paper
Card Stock
Transparency
Glossy
Labels
Envelope
Rough/Cotton

Specifies a paper type when the Recycled setting is selected in other menus

Notes:

• Paper is the factory default setting.
• The custom media type must be supported by the selected tray or feeder
in order for you to print from that source.

Notes:

• Paper is the factory default setting.
• The Recycled type must be supported by the selected tray or feeder in
order for you to print from that source.
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Universal Setup menu
Menu item

Description

Units of Measure
Inches
Millimeters

Identifies the units of measure

Portrait Width
3–14.17 inches
76–360 mm

Sets the portrait width

Notes:

• Inches is the US factory default setting.
• Millimeters is the international factory default setting.
Notes:

• If the width exceeds the maximum, then the printer uses the
maximum width allowed.

• 8.5 inches is the US factory default setting. Inches can be increased
in 0.01‑inch increments.

• 216 mm is the international factory default setting. Millimeters can
be increased in 1‑mm increments.
Portrait Height
3–14.17 inches
76–360 mm

Sets the portrait height
Notes:

• If the height exceeds the maximum, then the printer uses the
maximum height allowed.

• 14 inches is the US factory default setting. Inches can be increased in
0.01‑inch increments.

• 356 mm is the international factory default setting. Millimeters can
be increased in 1‑mm increments.
Feed Direction
Short Edge
Long Edge

Specifies the feed direction
Notes:

• Short Edge is the factory default setting.
• Long Edge appears only if the longest edge is shorter than the
maximum length supported in the tray.

Reports
Menu Settings Page menu
Menu item

Description

Menu Settings Page

Prints a report containing information about paper loaded into trays, installed
memory, the total page count, alarms, timeouts, the printer control panel
language, the TCP/IP address, the status of supplies, the status of the network
connection, and other information
Note: The page prints when this item is selected.
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Device Statistics menu
Menu item

Description

Device Statistics

Prints a report containing printer statistics such as supply information and details
about printed pages
Note: The page prints when this item is selected.

Network Setup Page menu
Menu item

Description

Network Setup Page

Prints a report containing information about the network settings, such as TCP/IP
address information
Notes:

• This menu item appears only for printers with a network print server
installed.

• The page prints when this item is selected.

Print Fonts menu
Menu item

Description

Print Fonts
PCL Fonts
PostScript Fonts

Prints a report of all the fonts available for the printer language currently set in
the printer
Note: A separate report is available for PCL and PostScript emulations. Each
emulator report contains print samples and information about the language's
available fonts.

Print Defects menu
Menu item

Description

Print Defects

Prints a diagnostic list of problems
Notes:

• The page prints when this item is selected.
• The list should be printed on letter- or A4-size paper.

Asset Report menu
Menu item

Description

Asset Report

Prints a report containing asset information including the printer serial number
and model name. The report contains text and UPC bar codes that can be
scanned into an asset database.
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Network/Ports
Active NIC menu
Menu item

Description

Active NIC
Auto
<list of available network cards>

Shows the print server
Notes:

• Auto is the factory default setting.
• This menu item appears only if an optional network card is installed.

Network menu
Menu item

Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job requires
it, regardless of the default printer language
Notes:

• On is the factory default setting.
• When the Off setting is used, the printer does not examine incoming data.
• When the Off setting is used, the printer uses PostScript emulation if PS
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PS SmartSwitch is set to Off.
PS SmartSwitch
On
Off

Sets the printer to automatically switch to PostScript emulation when a print job
requires it, regardless of the default printer language
Notes:

• On is the factory default setting.
• When the Off setting is used, the printer does not examine incoming data.
• When the Off setting is used, the printer uses PCL emulation if PCL
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PCL SmartSwitch is set to Off.
NPA Mode
Auto
Off

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol
Notes:

• Auto is the factory default setting.
• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
Network Buffer
Auto
Disabled

Sets the size of the network input buffer
Notes:

• Auto is the factory default setting.
• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
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Menu item

Description

Mac Binary PS
Auto
On
Off

Sets the printer to process Macintosh binary PostScript print jobs

Network Setup
Reports
Network Card
TCP/IP
IPv6
Wireless
AppleTalk

Sets printer settings on jobs sent through a network port

Notes:

• Auto is the factory default setting.
• The Off setting filters print jobs using the standard protocol.
• The On setting processes raw binary PostScript print jobs.
Note: Certain options are not available on selected printer models.

Reports menu
This menu is available from the Network/Ports menu:
Network/Ports > Network Menu > Reports
Menu item

Description

Print Setup Page Prints a report containing information about the current network setup
Note: The Setup Page contains information about the network printer settings, such as the TCP/IP
address.

Network Card menu
This menu is available from the Network/Ports menu:
Network/Ports > Network Menu > Network Card
Menu item

Description

View Card Status
Connected
Disconnected

Lets you view the connection status of the network card

View Card Speed

Lets you view the speed of a currently active network card

Network Address
UAA
LAA

Lets you view the network addresses
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Menu item

Description

Job Timeout

Sets the amount of time in seconds that a network print job can take before it
is canceled

0‑225 seconds

Notes:

• 90 seconds is the factory default setting.
• A setting value of 0 disables the timeout.
• If a value of 1–9 is selected, then the setting is saved as 10.
Banner Page
Off
On

Allows the printer to print a banner page
Note: Off is the factory default setting.

TCP/IP menu
Note: This menu is available only for network models or printers attached to print servers.
This menu is available from the Network/Ports menu:
Network/Ports > Network Menu > TCP/IP
Menu item

Description

Activate
On
Off

Activates TCP/IP

View Hostname

Lets you view the current TCP/IP hostname

Note: On is the factory default setting.

Note: This can be changed only from the Embedded Web Server.
IP Address

Lets you view or change the current TCP/IP Address
Note: Manually setting the IP address sets the Enable DHCP and Enable Auto IP
settings to Off.

Netmask

Lets you view or change the current TCP/IP Netmask

Gateway

Lets you view or change the current TCP/IP Gateway

Enable DHCP
On
Off

Specifies the DHCP address and parameter assignment setting

Enable Auto IP
Yes
No

Specifies the Zero Configuration Networking setting

Enable FTP/TFTP
Yes
No

Enables the built-in FTP server, which allows you to send files to the printer using the
File Transfer Protocol.

Enable HTTP Server
Yes
No

Enables the built-in Web server (Embedded Web Server). When enabled, the printer
can be monitored and managed remotely using a Web browser.

WINS Server Address

Lets you view or change the current WINS Server Address

Note: On is the factory default setting.

Note: Yes is the factory default setting.

Note: Yes is the factory default setting.

Note: Yes is the factory default setting.
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Menu item

Description

Enable DDNS/mDNS
Yes
No

Lets you view or change the current DDNS/mDNS Server Address

DNS Server Address

Lets you view or change the current DNS Server Address

Note: Yes is the factory default setting.

IPv6 menu
Note: The Internet Protocol version 6 (IPv6) menu is available only for network models or printers attached to print
servers.
This menu is available from the Network/Ports menu:
Network/Ports > Network Menu > IPv6
Menu item

Description

Enable IPv6
On
Off

Enables IPv6 in the printer

Auto Configuration
On
Off

Specifies whether the network adapter accepts the automatic IPv6
address configuration entries provided by a router

View Hostname

Lets you view the current setting

View Address

Note: These settings can be changed only from the Embedded Web
Server.

Note: On is the factory default setting.

Note: On is the factory default setting.

View Router Address
Enable DHCPv6
On
Off

Enables DHCPv6 in the printer
Note: On is the factory default setting.

Wireless menu
Use the following menu items to view or configure the wireless internal print server settings.
Note: This menu is available only for network models or printers attached to print servers when an optional wireless
internal print server is installed in the printer.
This menu is available from the Network/Ports menu:
Network/Ports > Network Menu > Wireless
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Menu item

Description

Network Mode
Ad hoc
Infrastructure

Specifies the network mode
Notes:

• Ad hoc is the factory default setting. Ad hoc mode configures the
printer for wireless networking directly between it and a computer.

• Infrastructure mode lets the printer access a network using an
access point.
Compatibility
802.11b/g/n
802.11n
802.11b/g

Specifies the wireless standard for the wireless network

Choose Network
<list of available networks>

Lets you select an available network for the printer to use

View Signal Quality

Lets you view the quality of the wireless connection

View Security Mode

Lets you view the encryption method for the wireless connection

Note: 802.11b/g/n is the factory default setting.

AppleTalk menu
This menu is available from the Network/Ports menu:
Network/Ports > Network Menu > AppleTalk
Menu item

Description

Activate
Yes
No

Activates AppleTalk support

View Name

Shows the assigned AppleTalk name

Note: Yes is the factory default setting.

Note: The name can be changed only from the Embedded Web Server.
View Address

Shows the assigned AppleTalk address
Note: The address can be changed only from the Embedded Web Server.

Set Zone
<list of zones available on the
network>

Provides a list of AppleTalk zones available on the network
Note: The default setting is the default zone for the network. If no default
zone exists, the zone marked with an * is the default setting.
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USB menu
Menu item

Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job requires
it, regardless of the default printer language
Notes:

• On is the factory default setting.
• When the Off setting is used, the printer does not examine incoming data.
• When the Off setting is used, the printer uses PostScript emulation if PS
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PS SmartSwitch is set to Off.
PS SmartSwitch
On
Off

Sets the printer to automatically switch to PostScript emulation when a print job
requires it, regardless of the default printer language
Notes:

• On is the factory default setting.
• When the Off setting is used, the printer does not examine incoming data.
• When the Off setting is used, the printer uses PCL emulation if PCL
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PCL SmartSwitch is set to Off.
NPA Mode
Auto
Off

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol
Notes:

• Auto is the factory default setting.
• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
USB Buffer
Auto
Disabled

Sets the size of the USB input buffer
Notes:

• Auto is the factory default setting.
• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.

Mac Binary PS
Auto
Off
On

Sets the printer to process Macintosh binary PostScript print jobs

USB With ENA
ENA Address
ENA Netmask
ENA Gateway

Sets the network address, netmask, or gateway information for an external print
server that is attached to the printer using a USB cable

Notes:

• Auto is the factory default setting.
• The Off setting filters print jobs using the standard protocol.
• The On setting processes raw binary PostScript print jobs.

Note: This menu item is available only if the printer is attached to an external
print server through the USB port.
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Settings
General Settings menu
Menu item

Description

Display Language
English
Francais
Deutsch
Italiano
Espanol
Dansk
Norsk
Nederlands
Svenska
Portugues
Suomi
Russian
Polski
Magyar
Turkce
Cesky
Simplified Chinese
Traditional Chinese
Korean
Japanese

Sets the language of the text appearing on the display

Eco‑Mode
Off
Energy
Energy/Paper
Paper

Minimizes the use of energy, paper, or specialty media

Note: All languages may not be available for all printers.

Notes:

• Off is the factory default setting. Off resets the printer to its
factory default settings.

• The Energy setting minimizes the power used by the printer.
Performance may be affected, but print quality is not.

• Energy/Paper minimizes the use of power and of paper and
specialty media.

• Paper minimizes the amount of paper and specialty media
needed for a print job. Performance may be affected, but
print quality is not.
Quiet Mode
Off
On

Reduces the amount of noise produced by the printer
Notes:

• Off is the factory default setting.
• On configures the printer to produce as little noise as
possible.
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Menu item

Description

Run Initial Setup
Yes
No

Instructs the printer to run the setup wizard
Notes:

• Yes is the factory default setting.
• After completing the setup wizard by selecting Done at the
Country select screen, the default setting becomes No.

Alarms
Cartridge Alarm

Sets an alarm to sound when the printer requires operator
intervention
Available selections are:

• Single
• Off
Notes:

• Single is the factory default setting for Alarm Control. Single
sounds three quick beeps.

• Off means no alarm will sound.
Timeouts
Power Saver
1–240 min

Specifies the number of minutes of inactivity before some systems
begin entering a minimum power state

Timeouts
Screen Timeout
15–300 sec

Sets the amount of time in seconds the printer waits before
returning the printer display to a Ready state

Timeouts
Print Timeout
Disabled
1–255 sec

Sets the amount of time in seconds the printer waits to receive an
end‑of‑job message before canceling the remainder of the print
job

Note: 30 minutes is the factory default setting.

Note: 30 seconds is the factory default setting.

Notes:

• 90 seconds is the factory default setting.
• When the timer expires, any partially printed page still in the
printer is printed, and then the printer checks to see if any
new print jobs are waiting.

• Print Timeout is available only when using PCL or PPDS
emulation. This setting has no effect on PostScript emulation
print jobs.
Timeouts
Wait Timeout
Disabled
15–65535 sec

Sets the amount of time in seconds the printer waits for additional
data before canceling a print job
Notes:

• 40 seconds is the factory default setting.
• Wait Timeout is available only when the printer is using
PostScript emulation. This setting has no effect on PCL or
PPDS emulation print jobs.
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Menu item

Description

Print Recovery
Auto Continue
Disabled
5–255 sec

Lets the printer automatically continue printing from certain offline
situations when not resolved within the specified time period

Print Recovery
Jam Recovery
Auto
On
Off

Specifies whether the printer reprints jammed pages

Note: Disabled is the factory default setting.

Notes:

• Auto is the factory default setting. The printer reprints
jammed pages unless the memory required to hold the
pages is needed for other printer tasks.

• On sets the printer to always reprint jammed pages.
• Off sets the printer to never reprint jammed pages.
Print Recovery
Page Protect
Off
On

Lets the printer successfully print a page that may not have printed
otherwise
Notes:

• Off is the factory default setting. Off prints a partial page
when there is not enough memory to print the whole page.

• On sets the printer to process the whole page so that the
entire page prints.
Factory Defaults
Do Not Restore
Restore

Returns the printer settings to the factory default settings
Notes:

• Do Not Restore is the factory default setting. Do Not Restore
keeps the user‑defined settings.

• Restore returns all printer settings to the factory default
settings except Network/Ports menu settings. All downloads
stored in RAM are deleted. Downloads stored in flash
memory or on a printer hard disk are not affected.

Setup menu
Menu item

Description

Printer Language
PCL Emulation
PS Emulation
PPDS Emulation

Sets the default printer language
Notes:

• PCL is the factory default printer language.
• PCL emulation uses a PCL interpreter for processing print
jobs. PostScript emulation uses a PS interpreter for
processing print jobs. PPDS emulation uses a PPDS
interpreter for processing print jobs

• Setting a printer language as the default does not prevent a
software program from sending print jobs that use another
printer language.
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Menu item

Description

Print Area
Normal
Fit to Page
Whole Page

Sets the logical and physical printable area

Download Target
RAM
Flash

Sets the storage location for downloads

Note: Normal is the factory default setting. When attempting to
print data in the non‑printable area defined by the Normal
setting, the printer clips the image at the boundary.

Notes:

• RAM is the factory default setting.
• Storing downloads in flash memory places them in
permanent storage. Downloads remain in flash memory even
when the printer is turned off.

• Storing downloads in RAM is temporary.
• This menu appears only if a flash option is installed.
Resource Save
Off
On

Specifies how the printer handles temporary downloads, such as
fonts and macros stored in RAM, when the printer receives a job
that requires more memory than is available
Notes:

• Off is the factory default setting. Off sets the printer to retain
the downloads only until memory is needed. Downloads are
deleted in order to process print jobs.

• The On setting retains the downloads during language
changes and printer resets. If the printer runs out of
memory, 38 Memory Full appears, and downloads are
not deleted.

Finishing menu
Menu item

Description

Sides (Duplex)
1 sided
2 sided

Specifies whether duplex (2‑sided) printing is set as the default for all print jobs
Notes:

• 1 sided is the factory default setting.
• To set 2‑sided printing from the software program: for Windows users, click
File > Print, and then click Properties, Preferences, Options, or Setup; for
Macintosh users, choose File > Print, and then adjust the settings from the
Print dialog and pop‑up menus.

Duplex Binding
Long Edge
Short Edge

Defines the way duplexed pages are bound and how the printing on the back of the
page is oriented in relation to the printing on the front of the page
Notes:

• Long Edge is the factory default setting.
• Long Edge specifies that binding be placed on the left edge of portrait pages
and the top edge of landscape pages.

• Short Edge specifies that binding be placed on the top edge of portrait pages
and the left edge of landscape pages.
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Menu item

Description

Copies
1–999

Specifies a default number of copies for each print job

Blank Pages
Do Not Print
Print

Specifies whether blank pages are inserted in a print job

Collate
Off (1,1,1,2,2,2)
On (1,2,1,2,1,2)

Stacks the pages of a print job in sequence when printing multiple copies

Note: 1 is the factory default setting.
Note: Do Not Print is the factory default setting.

Notes:

• Off is the factory default setting. No pages will be collated.
• The On setting stacks the print job sequentially.
• Both settings print the entire job the number of times specified by the Copies
menu setting.

Separator Sheets
None
Between Copies
Between Jobs
Between Pages

Specifies whether blank separator sheets are inserted
Notes:

• None is the factory default setting.
• Between Copies inserts a blank sheet between each copy of a print job if
Collation is set to On. If Collation is set to Off, a blank page is inserted between
each set of printed pages, such as after all page 1's and after all page 2's.

• Between Jobs inserts a blank sheet between print jobs.
• Between Pages inserts a blank sheet between each page of the print job. This
setting is useful when printing transparencies or inserting blank pages in a
document for notes.
Separator Source
Tray <x>
MP Feeder

Specifies the paper source for separator sheets
Notes:

• Tray 1 (standard tray) is the factory default setting.
• From the Paper menu, Configure MP must be set to Cassette in order for
Multi‑Purpose Feeder to appear as a menu setting.

N‑up (pages‑side)
Off
2‑Up
3‑Up
4‑Up
6‑Up
9‑Up
12‑Up
16‑Up

Specifies that multiple‑page images be printed on one side of a sheet of paper

N‑up Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specifies the positioning of multiple‑page images when using N‑up (pages‑sides)

Notes:

• Off is the factory default setting.
• The number selected is the number of page images that will print per side.

Notes:

• Horizontal is the factory default setting.
• Positioning depends on the number of images and whether the images are in
portrait or landscape orientation.

Understanding printer menus

84

Menu item

Description

Orientation
Auto
Landscape
Portrait

Specifies the orientation of a multiple‑page sheet

N‑up Border
None
Solid

Prints a border around each page image when using N‑up (pages‑sides)

Note: Auto is the factory default setting. The printer chooses between portrait and
landscape.

Note: None is the factory default setting.

Quality menu
Menu item

Description

Color Correction
Auto
Off
Manual

Adjusts the color output on the printed page
Notes:

• Auto is the factory default setting. Auto applies different color conversion tables
to each object on the printed page.

• Off turns off color correction.
• Manual allows customization of the color tables using the settings available from
the Manual Color menu.

• Due to the differences in additive and subtractive colors, certain colors that
appear on computer monitors are impossible to duplicate on the printed page.
Print Resolution
4800 CQ
1200 dpi

Specifies the printed output resolution

Toner Darkness
1–5

Lightens or darkens the printed output

Note: 4800 CQ is the factory default setting.

Notes:

• 4 is the factory default setting.
• Selecting a smaller number can help conserve toner.
• If Print Mode is set to Black Only, a setting of 5 increases toner density and
darkness to all print jobs.

• If Print Mode is set to Color, a setting of 5 is the same as a setting of 4.
Enhance Fine Lines
Off
On

Enables a print mode preferable for files such as architectural drawings, maps, electrical
circuit diagrams, and flow charts
Notes:

• Off is the factory default setting.
• To set Enhance Fine Lines from the software program: for Windows users, click
File > Print, and then click Properties, Preferences, Options, or Setup; for
Macintosh users, choose File > Print, and then adjust the settings from the Print
dialog and pop‑up menus.
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Menu item

Description

Color Saver
Off
On

Reduces the amount of toner used for graphics and images. The amount of toner used
for text is not reduced.
Notes:

• Off is the factory default setting.
• On overrides Toner Darkness settings.
RGB Brightness
‑6–6

Adjusts brightness in color outputs
Notes:

• 0 is the factory default setting.
• ‑6 is the maximum decrease. 6 is the maximum increase.
RGB Contrast
0–5

Adjusts contrast in color outputs

RGB Saturation
0–5

Adjusts saturation in color outputs

Color Balance
Cyan
Magenta
Yellow
Black

Adjusts color in printed output by increasing or decreasing the amount of toner used
for each color

Color Balance
Reset Defaults

Restores the Color Balance factory default settings

Color Samples
sRGB Display
sRGB Vivid
Display—True Black
Vivid
Off—RGB
US CMYK
Euro CMYK
Vivid CMYK
Off—CMYK

Prints sample pages for each of the RGB and CMYK color conversion tables used in the
printer

Note: 0 is the factory default setting.
Note: 0 is the factory default setting.

Notes:

• 0 is the factory default setting.
• Available selections for each setting are ‑5 to 5.

Notes:

• Selecting any setting prints the sample.
• Color samples consist of a series of colored boxes along with the RGB or CMYK
combination that creates the color observed. These pages can be used to help
decide which combinations to use to get the desired printed output.

• From a browser window, type the IP address of the printer to access a complete
list of color sample pages from the Embedded Web Server.
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Menu item

Description

Manual Color
RGB Image
RGB Text
RGB Graphics

Customizes the RGB color conversions
Available selections for each setting are:
Vivid
sRGB Display
Display—True Black
sRGB Vivid
Off
Notes:

• sRGB Display is the factory default setting for RGB Image. This applies a color
conversion table to an output that matches the colors displayed on a computer
monitor.

• sRGB Vivid is the factory default setting for RGB Text and RGB Graphics. sRGB
Vivid applies a color conversion table that increases saturation. This is preferred
for business graphics and text.

• Vivid applies a color conversion table that produces brighter, more saturated
colors.

• Display—True Black applies a color conversion table that uses only black toner
for neutral gray colors.

• Off turns off color conversion.
Manual Color
CMYK Image
CMYK Text
CMYK Graphics

Customizes the CMYK color conversions
Available selections for each setting are:
US CMYK
Euro CMYK
Vivid CMYK
Off
Notes:

• US CMYK is the US factory default setting. US CMYK applies a color conversion
table that tries to produce output that matches SWOP color output.

• Euro CMYK is the international factory default setting. Euro CMYK applies a color
conversion table that tries to produce output that matches EuroScale color
output.

• Vivid CMYK increases color saturation for the US CMYK color conversion table.
• Off turns off color conversion.
Color Adjust

Initiates an automatic color adjust calibration
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Utilities menu
Menu item

Description

Format Flash
No
Yes

Formats the flash memory. Flash memory refers to the memory added by installing
an optional flash memory card in the printer.
Warning—Potential Damage: Do not turn off the printer while the flash memory is
formatting.
Notes:

• An optional flash memory card must be installed in the printer and operating
properly for this menu item to be available. The optional flash memory card
must not be Read/Write or Write protected.

• No cancels the format request.
• Yes deletes all data stored in flash memory.
Defragment Flash
No
Yes

Prepares the flash memory to receive new data by retrieving lost storage space
Warning—Potential Damage: Do not turn off the printer while the flash memory is
defragmenting.
Notes:

• An optional flash memory card must be installed in the printer and operating
properly for this menu item to be available. The optional flash memory card
must not be Read/Write or Write protected.

• No cancels the defragment request.
• Yes reformats the flash memory after transferring all downloads to regular
printer memory. When formatting is complete, the downloads are loaded back
into flash memory.
Hex Trace
Activate

Assists in isolating the source of a print job problem
Notes:

• When Activate is selected, all data sent to the printer is printed in
hexadecimal, and character representation and control codes are not
executed.

• To exit Hex Trace, turn the printer off or reset the printer.
Coverage Estimator
Off
On

Provides an estimate of the percentage coverage of cyan, magenta, yellow, and black
toner on a page. The estimate is printed on a separator page.
Note: Off is the factory default setting.

PDF menu
Note: Certain options are not available on selected printer models.
Menu item

Description

Scale to Fit
No
Yes

Scales page content to fit the selected paper size
Note: No is the factory default setting.
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Menu item

Description

Annotations
Do Not Print
Print

Prints annotations in a PDF
Note: Do Not Print is the factory default setting.

PostScript menu
Menu item

Description

Print PS Error
Off
On

Prints a page containing the PostScript error

Font Priority
Resident
Flash

Establishes the font search order

Note: Off is the factory default setting.

Notes:

• Resident is the factory default setting.
• A formatted flash memory option card or printer hard disk must be
installed in the printer and operating properly for this menu item to be
available.

• The flash memory option or printer hard disk cannot be Read/Write,
Write, or password protected.

• Job Buffer Size must not be set to 100%.
Image Smoothing
Off
On

Enhances the contrast and sharpness of low‑resolution images and smooths
their color transitions
Notes:

• Off is the factory default setting.
• Image Smoothing has no effect on images that are 300 dpi or higher in
resolution.

PCL Emul menu
Menu item

Description

Font Source
Resident
Download
Flash
All

Specifies the set of fonts used by the Font Name menu item
Notes:

• Resident is the factory default setting. It shows the factory default set of
fonts downloaded into RAM.

• Flash settings show all fonts resident in that option.
• Flash options must be properly formatted and cannot be Read/Write,
Write, or password protected.

• Download shows all the fonts downloaded into RAM.
• All shows all fonts available to any option.
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Menu item

Description

Font Name
Courier

Identifies a specific font and the option where it is stored
Notes:

• Courier is the factory default setting.
• Courier shows the font name, font ID, and storage location in the printer.
The font source abbreviation is R for Resident, F for Flash, and D for
Download.
Symbol Set
10U PC‑8
12U PC‑850

Specifies the symbol set for each font name
Notes:

• 10U PC‑8 is the US factory default setting.
• 12U PC‑850 is the international factory default setting.
• A symbol set is a set of alphabetic and numeric characters, punctuation,
and special symbols. Symbol sets support the different languages, or
specific programs such as math symbols for scientific text. Only the
supported symbol sets are shown.

PCL Emulation Settings
Point Size
1.00–1008.00

Changes the point size for scalable typographic fonts
Notes:

• 12 is the factory default setting.
• Point Size refers to the height of the characters in the font. One point
equals approximately 1/72 of an inch.

• Point sizes can be increased or decreased in 0.25‑point increments.
PCL Emulation Settings
Pitch
0.08–100

Specifies the font pitch for scalable monospaced fonts
Notes:

•
•
•
•

10 is the factory default setting.
Pitch refers to the number of fixed‑space characters per inch (cpi).
Pitch can be increased or decreased in 0.01‑cpi increments.
For nonscalable monospaced fonts, the pitch appears on the display but
cannot be changed.

PCL Emulation Settings
Orientation
Portrait
Landscape

Specifies the orientation of text and graphics on the page

PCL Emulation Settings
Lines per Page
1–255
60
64

Specifies the number of lines that print on each page

Notes:

• Portrait is the factory default setting.
• Portrait prints text and graphics parallel to the short edge of the page.
• Landscape prints text and graphics parallel to the long edge of the page.
Notes:

• 60 is the US factory default setting. 64 is the international factory default
setting.

• The printer sets the amount of space between each line based on the
Lines per Page, Paper Size, and Orientation settings. Select the desired
Paper Size and Orientation before setting Lines per Page.
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Menu item

Description

PCL Emulation Settings
A4 Width
198 mm
203 mm

Sets the printer to print on A4‑size paper
Notes:

• 198 mm is the factory default setting.
• The 203‑mm setting sets the width of the page to allow the printing of
eighty 10‑pitch characters.

PCL Emulation Settings
Auto CR after LF
Off
On

Specifies whether the printer automatically performs a carriage return (CR) after
a line feed (LF) control command

PCL Emulation Settings
Auto LF after CR
Off
On

Specifies whether the printer automatically performs a line feed (LF) after a
carriage return (CR) control command

Tray Renumber
Assign MP Feeder
Assign Tray <x>
Assign Manual Paper
Assign Man Env

Configures the printer to work with printer software or programs that use
different source assignments for trays, drawers, and feeders

Notes:

• Off is the factory default setting.
• Changes to these settings are duplicated in the PPDS menu.

Notes:

• Off is the factory default setting.
• Changes to these settings are duplicated in the PPDS menu.

Available selections for each setting are:
Off
None
0–199
Notes:

• Off is the factory default setting.
• None is not an available selection. It is displayed only when it is selected
by the PCL 5 interpreter.

• None ignores the Select Paper Feed command.
• 0–199 allows a custom setting to be assigned.
Tray Renumber
View Factory Def

Displays the factory default setting assigned to each tray, drawer, or feeder

Tray Renumber
Restore Defaults
Yes
No

Returns all tray, drawer, and feeder assignments to the factory default settings
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Image menu
Menu item

Description

Auto Fit
On
Off

Selects the optimal paper size, scaling, and orientation

Invert
Off
On

Inverts bi‑tonal monochrome images

Scaling
Best Fit
Anchor Top Left
Anchor Center
Fit Height/Width
Fit Height
Fit Width

Scales the image to fit the selected paper size

Orientation
Portrait
Landscape
Rev Portrait
Rev Landscape

Sets the image orientation

Notes:

• On is the factory default setting.
• The On setting overrides scaling and orientation settings for some images.
Notes:

• Off is the factory default setting.
• The font size can be increased in 1‑point increments.
• This setting does not apply to GIF or JPEG images.
Notes:

• Best Fit is the factory default setting.
• When Auto Fit is set to On, Scaling is automatically set to Best Fit.

Note: Portrait is the factory default setting.

PictBridge menu
Note: Certain options are not available on select printer models.
Menu item

Description

Photo Size
Auto
L
2L
Hagaki Postcard
Card Size
100 x 150 mm
4 x 6 in
8 x 10 in
Letter
A4
A5
JIS B5

Controls the size of each photo printed from a PictBridge‑enabled digital camera
Notes:

• Auto is the factory default setting.
• If both the printer and the PictBridge‑enabled digital camera have a value for
this setting, the camera value always supersedes the printer value.
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Menu item

Description

Layout
Auto
Off
2 Up
3 Up
4 Up
6 Up
9 Up
12 Up
16 Up
Index Print

Determines the maximum number of images that can be printed on one side of the
paper

Quality
Normal
Draft
Fine

Determines which resolution, toner darkness, and color saver values the printer uses
when printing photos sent from a PictBridge‑enabled digital camera

Notes:

• Auto is the factory default setting.
• If both the printer and the PictBridge‑enabled digital camera have a value for
this setting, the camera value always supersedes the printer value.

Notes:

• Normal is the factory default setting.
• If both the printer and the PictBridge‑enabled camera have a value for this
setting, the camera value always supersedes the printer value.

Paper Source
Manual Paper
MP Feeder
Tray <x>

Identifies the printer default input source when printing photos from a
PictBridge‑enabled digital camera
Notes:

• Manual Paper is the factory default setting.
• A photo size larger than the size of the media installed in the
PictBridge‑enabled digital camera cannot be selected.

Flash drive menu
Note: The USB Direct Interface is not available on select printer models.
Menu item

Description

Enable Drive
Enable
Disable

Enables or disables the USB port on the front of the printer

Update Code
Enable
Disable

Enables or disables the ability of the flash drive to update the firmware code by way
of a USB device

Copies
1–999

Sets the number of copies the printer should produce for each page contained in a
print job

Note: Enable is the factory default setting.

Note: Enable is the factory default setting.

Note: 1 is the factory default setting.
Sides (Duplex)
1 sided
2 sided

Controls whether the printer prints on one side or both sides of the paper
Note: 1 sided is the factory default setting.
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Maintaining the printer
Periodically, certain tasks are required to maintain optimum print quality.

Storing supplies
Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original packing until you
are ready to use them.
Do not expose supplies to:

•
•
•
•
•
•

Direct sunlight
Temperatures above 35°C (95°F)
High humidity above 80%
Salty air
Corrosive gases
Heavy dust

Checking the status of supplies
A message appears on the display when a replacement supply item is needed or when maintenance is required.

Checking the status of supplies from the printer control panel
You can check the status of printer supplies by printing a menu settings page:

1 Make sure the printer is on and Ready appears.
2 From the printer control panel, press

.

3 Press the arrow buttons until Reports appears, and then press

.

4 Press the arrow buttons until Menu Settings Page appears, and then press

.

Checking the status of supplies from a network computer
Note: The computer must be connected to the same network as the printer.

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, print a network setup page and locate the IP address in
the TCP/IP section.

2 Click Device Status. The Device Status page appears, displaying a summary of supply levels.
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Ordering supplies
To order supplies in the U.S., contact Lexmark at 1-800-539-6275 for information about Lexmark authorized supplies
dealers in your area. In other countries or regions, visit the Lexmark Web Site at www.lexmark.com or contact the place
where you purchased the printer.
Note: All life estimates for printer supplies assume printing on letter‑ or A4‑size plain paper.

Ordering toner cartridges
When 88 Cyan Cartridge Low, 88 Magenta Cartridge Low, 88 Yellow Cartridge Low, or 88
Black Cartridge low appears, order a new cartridge.
When 88 Replace Cyan Cartridge, 88 Replace Magenta Cartridge, 88 Replace Yellow
Cartridge, or 88 Replace Black Cartridge appears, you must replace the specified toner cartridge.
Part name

Part number

Black Return Program
Toner Cartridge

C540A1KG

Cyan Return Program
Toner Cartridge

C540A1CG

Magenta Return
Program Toner
Cartridge

C540A1MG

Yellow Return Program
Toner Cartridge

C540A1YG

Black High Yield Return
Program Toner
Cartridge

C540H1KG

Cyan High Yield Return
Program Toner
Cartridge

C540H1CG

Magenta High Yield
Return Program Toner
Cartridge

C540H1MG

Yellow High Yield
Return Program Toner
Cartridge

C540H1YG

Black High Yield Toner
Cartridge

C540H2KG

Cyan High Yield Toner
Cartridge

C540H2CG

Magenta High Yield
Toner Cartridge

C540H2MG

Yellow High Yield Toner
Cartridge

C540H2YG

C540 and C543

C544

C546
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Part number

C540 and C543

C544

Black Extra High Yield
Return Program Toner
Cartridge

C544X1KG

X

Cyan Extra High Yield
Return Program Toner
Cartridge

C544X1CG

X

Magenta Extra High
Yield Return Program
Toner Cartridge

C544X1MG

X

Yellow Extra High Yield
Return Program Toner
Cartridge

C544X1YG

X

Black Extra High Yield
Toner Cartridge

C544X2KG

X

Cyan Extra High Yield
Toner Cartridge

C544X2CG

X

Magenta Extra High
Yield Toner Cartridge

C544X2MG

X

Yellow Extra High Yield
Toner Cartridge

C544X2YG

X

Black Extra High Yield
Return Program Toner
Cartridge

C546U1KG

X

X

Black Extra High Yield
Toner Cartridge

C546U2KG

X

X

C546
X

X

Ordering imaging kits
When Replace black and color imaging kit or Replace black imaging kit appears, order a
replacement imaging kit.
Part name

Part number

C540, C543, C544

Black and Color Imaging Kit

C540X74G

Black Imaging Kit

C540X71G

Photoconductor Unit

C540X35G

Not Supported

Black Developer Unit

C540X31G

Not Supported

Cyan Developer Unit

C540X32G

Not Supported

Magenta Developer Unit

C540X33G

Not Supported

Yellow Developer Unit

C540X34G

Not Supported

C546
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Ordering a waste toner bottle
When 82 Replace Waste Toner appears, order a replacement waste toner box. The waste toner box must be
replaced when 82 Replace Waste Toner appears.
Part name

Part number

Waste toner bottle

C540X75G
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Replacing supplies
Replacing the waste toner box
Replace the waste toner box when 82 Replace waste toner appears. The printer will not continue printing until
the waste toner box is replaced.
1

2

4

1

Top door

2

Waste toner box

3

Right side cover

4

Front door

3

1 Unpack the replacement waste toner box.
2 Grasp the front door at the sides, and then pull it toward you.
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
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3 Open the top door by sliding the button forward.

4 Remove the right side cover.
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5 Press the green levers on each side of the waste toner box, and then remove it.

6 Place the waste toner box in the enclosed packaging.
For more information, see “Recycling Lexmark products” on page 36.

7 Insert the new waste toner box.

8 Replace the right side cover.
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9 Close the top door.

10 Close the front door.

Replacing a black and color imaging kit
Replace the black and color imaging kit when 31.yy Defective Imaging Kit appears.

1 Grasp the front door at the sides, and then pull it toward you.
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
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2 Open the top door by sliding the button forward.

3 Remove the toner cartridges by lifting the handles, and then gently pulling them away from the imaging kit.

4 Remove the right side cover.
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5 Press the green levers on each side of the waste toner box, and then remove it.

6 Lift the blue levers on the imaging kit, and then pull it toward you.

7 Press down on the blue levers, grasp the green handles on the sides, and then pull the imaging kit out.
Warning—Potential Damage: Do not touch the underside of the imaging kit. This could damage the imaging kit.
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8 Remove the yellow, cyan, magenta, and black developer units.

9 Unpack the replacement black and color imaging kit, and leave the packaging on the developer units.
10 Gently shake the yellow, cyan, magenta, and black developer units side to side.
11 Remove the packaging from the developer units.
12 Insert the yellow, cyan, magenta, and black developer units.

Note: Make sure each developer unit is inserted into a matching color slot.

13 Place the used black and color imaging kit in the enclosed package.
For more information, see “Recycling Lexmark products” on page 36.
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14 Align and insert the imaging kit.

15 Gently, but firmly push the blue levers down until the imaging kit drops into place.

16 Replace the waste toner box.
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17 Replace the right side cover.

18 Replace the toner cartridges.

19 Close the top door.
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20 Close the front door.

Replacing a toner cartridge
Replace the specified toner cartridge (yellow, cyan, magenta, or black) when 88 Replace <color>
Cartridge appears. The printer will not continue printing until the specified cartridge is replaced.
Warning—Potential Damage: Damage caused by use of a non‑Lexmark toner cartridge is not covered under
warranty.
Note: Degraded print quality may result from using non‑Lexmark toner cartridges.

1 Make sure the printer is on and Ready or 88 Replace <color> Cartridge appears.
2 Unpack the new cartridge, and then set it near the printer.

Y

C

Y

M

C

K

M

K

3 Open the top door by sliding the button forward.
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Y

M

C

K

M

Y
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4 Remove the toner cartridge by lifting the handle, and then gently pulling it away from the imaging kit.

C

Y

M

C

K

M

Y

K

5 Align the new toner cartridge, and then press down until it clicks into place.
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6 Close the top door.

Replacing a developer unit
Replace a developer unit when a print quality defect occurs.
Note: When a developer unit is replaced, you must manually calibrate the color. For more information, see “Color
misregistration” on page 148.

1 Grasp the front door at the sides, and then pull it toward you.
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

2 Open the top door by sliding the button forward.
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3 Remove the toner cartridges by lifting the handles and then gently pulling them away from the imaging kit.

4 Remove the right side cover.

5 Press the green levers on each side of the waste toner bottle, and then remove it.
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6 Lift the blue levers on the imaging kit, and then pull it toward you.

7 Press down on the blue levers, grasp the handles on the sides, and then pull the imaging kit out.
Warning—Potential Damage: Do not touch the underside of the imaging kit. This could damage the imaging kit.

8 Remove the used developer unit.

9 Place the used developer unit in the enclosed package.
For more information, see “Recycling Lexmark products” on page 36.

10 Unpack the replacement developer unit, and leave the packaging on.
11 Gently shake the developer unit from side to side.
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12 Remove the red shipping cover from the developer unit.

13 Insert the developer unit.

14 Align and insert the imaging kit.
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15 Gently, but firmly push the blue levers down until the imaging kit drops into place.

16 Replace the waste toner box.

17 Replace the right side cover.
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18 Replace the toner cartridges.

19 Close the top door.

20 Close the front door.

Cleaning the exterior of the printer
1 Make sure that the printer is turned off and unplugged from the wall outlet.
CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the printer,
unplug the power cord from the wall outlet and disconnect all cables from the printer before proceeding.

2 Remove paper from the standard exit tray.
3 Dampen a clean, lint‑free cloth with water.
Warning—Potential Damage: Do not use household cleaners or detergents, as they may damage the finish of
the printer.
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4 Wipe only the outside of the printer, making sure to include the standard exit tray.
Warning—Potential Damage: Using a damp cloth to clean the interior may cause damage to your printer.

5 Make sure the standard exit tray is dry before beginning a new print job.

Moving the printer
Before moving the printer
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.
CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet.
• Disconnect all cords and cables from the printer before moving it.
• Lift the printer off the optional tray, and then set it aside instead of trying to lift the tray and printer at the same
time.
Note: Use the handholds located on both sides of the printer to lift it.
Warning—Potential Damage: Damage to the printer caused by improper moving is not covered by the printer
warranty.

Moving the printer to another location
The printer and options can be safely moved to another location by following these precautions:

• Any cart used to move the printer must have a surface able to support the full footprint of the printer. Any cart
used to move the options must have a surface able to support the dimensions of the options.

• Keep the printer in an upright position.
• Avoid severe jarring movements.

Shipping the printer
When shipping the printer, use the original packaging or call the place of purchase for a relocation kit.
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Administrative support
Restoring the factory default settings
Menu settings marked with an asterisk (*) indicate the active settings. You can restore the original printer settings,
often referred to as the factory default settings. If you want to retain a list of the current menu settings for reference,
then print a menu settings page before you restore the factory default settings.
Warning—Potential Damage: Restoring factory default settings returns most printer settings to the original factory
default setting. All downloaded resources in the printer memory are deleted. This includes fonts, macros, and
symbol sets.

1 Make sure the printer is on and Ready appears.
2 From the printer control panel, press

.

3 Press the arrow buttons until Settings appears, and then press

.

4 Press the arrow buttons until General Settings appears, and then press

.

5 Press the arrow buttons until Factory Defaults appears, and then press

.

6 Press the arrow buttons until Restore Now appears, and then press

.

Submitting changes appears briefly.

7 Press

, and then press

until Ready appears.

Using the Embedded Web Server
If the printer is installed on a network, the Embedded Web Server is available for a range of functions:

•
•
•
•
•
•
•
•
•

Configuring printer settings
Checking the status of the printer supplies
Configuring network settings
Viewing reports
Restoring the factory default settings
Viewing the virtual display
Setting Web page password protect
Setting Panel PIN protect
Setting the date and time

To access the Embedded Web Server:

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click one of the tabs to access information about the printer, change settings, or view a report.
Note: If the printer is connected to a computer by a USB or parallel cable, then open the Local Printer Settings Utility
for Windows or Printer Settings for Macintosh to access printer menus.
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Setting up e‑mail alerts
You can have the printer send you an e‑mail when the supplies are getting low or when the paper needs to be changed,
added, or unjammed.
To set up e‑mail alerts:

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Under Other Settings, click E‑mail Alert Setup.
4 Select the items for notification and type in the e‑mail addresses that you want to receive e‑mail alerts.
5 Click Submit.
Note: See your system support person to set up the e‑mail server.

Configuring supply notifications
You can determine how you would like to be notified when supplies run low or reach their end‑of‑life.
To configure supply notifications using the Embedded Web Server:

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Click Print Settings.
4 Click Supply Notifications.
5 From the drop‑down box for each supply, select among the options for notification. Explanations for each option
are provided.

6 Click Submit to save your selections.

Copying printer settings to other printers
Using the Embedded Web Server, you can copy printer settings to up to 15 other network printers. To copy printer
settings:

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Copy Printer Settings.
3 To change the language, select a language from the drop‑down list, and then click Click here to submit language.
4 Click Printer Settings.
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5 Enter the IP addresses of the source and target printers.
Note: To add additional target printers, click the Add Target IP button.

6 Click Copy Printer Settings.
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Clearing jams
Jam error messages appear on the printer control panel display and include the area of the printer where the jam
occurred. When there is more than one jam, the number of jammed pages is displayed.

Avoiding jams
The following hints can help you avoid jams:

Paper tray recommendations
•
•
•
•
•

Make sure the paper lies flat in the tray.
Do not remove a tray while the printer is printing.
Do not load a tray while the printer is printing. Load it prior to printing, or wait for a prompt to load it.
Do not load too much paper. Make sure the stack height does not exceed the indicated maximum height.
Make sure the guides in the tray or the multipurpose feeder are properly positioned and are not pressing too tightly
against the paper or envelopes.

• Push the tray in firmly after loading paper.

Paper recommendations
• Use only recommended paper or specialty media.
• Do not load wrinkled, creased, damp, bent, or curled paper.
• Flex, fan, and straighten paper before loading it.

•
•
•
•

Do not use paper that has been cut or trimmed by hand.
Do not mix paper sizes, weights, or types in the same stack.
Make sure all sizes and types are set correctly in the printer control panel menus.
Store paper per the manufacturer's recommendations.

Understanding jam numbers and locations
When a jam occurs, a message indicating the jam location appears. Open doors and covers, and remove trays to access
jam locations.
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Jam number

Access point

200

250‑sheet tray (Tray 1) and manual
feeder

201

Under the fuser

202

In the fuser

230–231and 235

In the duplex area

Note: A 235 jam number indicates that
the paper or specialty media being
used for a duplex print job is not
supported.
24x

To access the jam

1 Open the front door, and then
remove any jams.
2 Open the fuser cover, and then
remove any jams.
3 Close the fuser cover.

4 Close the front door.
5 Pull out Tray 1, and then remove any
jams.

6 Reinsert Tray 1.
550‑sheet tray

1 Pull the 550‑sheet tray out, and
then remove any jams.
2 Reinsert the tray.

250

In the multipurpose feeder

1 Press the release latch to the left to
release the multipurpose feeder.

2 Inspect the multipurpose feeder,
and then remove any jams.

3 Close the multipurpose feeder.
Note: You may need to open the
650‑sheet duo tray to remove jammed
pages behind the multipurpose feeder.

200–202 and 230 paper jams
1 If the jam is in the paper tray:
a Grasp the handle, and pull the standard 250-sheet tray (Tray 1) and manual feeder out.

b Remove the jam.
Note: Make sure all paper fragments are removed.
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c Insert the tray.
d Press

.

2 If the jam is inside the printer:
a Grasp the front door at the side handholds, and then pull it toward you to open it.
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a
hot component, allow the surface to cool before touching.

b If the jam is visible, remove the jammed paper.

Note: Make sure all paper fragments are removed.

c If the jam is in the fuser area, grasp the green lever, and then pull the fuser cover toward you
d Hold the fuser cover down, and then remove the jammed paper.
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The fuser cover closes when released.

Note: Make sure all paper fragments are removed.

e Close the front door.
f Press

.
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231 and 235 paper jams
1 Grasp the front door at the side handholds, and then pull it toward you to open it.
2 Remove the jam.
3 Load the tray with the correct paper size.
4 Insert the tray.
5 Close the front door.
6 Press

.

24x paper jam
1 Grasp the handle, and pull the optional 550‑sheet tray out.

Note: The optional 550‑sheet tray is not available on all printer models.

2 Remove the jammed paper.
Note: Make sure all paper fragments are removed.

3 Insert the tray.
4 Press

.
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250 paper jam
1 Push the lever in the multipurpose feeder down to access the jammed paper.

2 Remove the jam.
Note: Make sure all paper fragments are removed.

3 Insert the tray.
4 Press

.
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Troubleshooting
Understanding printer messages
Calibrating
The printer is adjusting the color. Wait for the message to clear.

Close door
Close the upper and lower doors.

Insert Tray <x>
Insert the specified tray into the printer.

Reload printed pages in Tray <x>
• Press
• Press

to clear the message and continue processing the second side of the sheet.
, and then press

to cancel printing.

Load <input src> with <custom type name>
Try one or more of the following:

• Load the specified paper to clear the message and continue printing.
• Press
, and then press
to cancel the print job.

Load <input src> with <custom string>
Try one or more of the following:

• Load the specified paper to clear the message and continue printing.
• Press
, and then press
to cancel printing.

Load <input src> with <size>
Try one or more of the following:

• Load the paper tray or other source with the correct paper type and size.
• Press
, and then press
to cancel the print job.
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Load <input src> with <type> <size>
Try one or more of the following:

• Load the paper tray or other source with the correct paper type and size.
• Press
, and then press
to cancel the print job.

Load single sheet feeder with <custom type name>
Try one or more of the following:

• Load the manual feeder with the correct paper type and size.
If there is no paper in the feeder, load a sheet, and then press

• Press

to clear the message and continue printing.

to clear the message and continue printing.

The printer manually overrides the request, and then prints from an automatically selected tray.

• Press

, and then press

to cancel the print job.

Load single sheet feeder with <custom string>
Try one or more of the following:

• Load the manual feeder with the correct paper type and size.
If there is no paper in the feeder, load a sheet, and then press

to clear the message and continue printing.

• Select the paper type and size to manually override the request.
• Press
, and then press
to cancel the print job.

Load single sheet feeder with <size>
Try one or more of the following:

• Load the manual feeder with the correct paper type and size.
If there is no paper in the feeder, load a sheet of paper, and then press
printing.

to clear the message and continue

• Select the paper type and size to manually override the request.
• Press
to clear the message and continue printing.
The printer manually overrides the request, and then prints from an automatically selected tray.

• Press

, and then press

to cancel the print job.

Load single sheet feeder with <type> <size>
Try one or more of the following:

• Load the manual feeder with the correct paper type and size.
If there is no paper in the feeder, load a sheet, and then select

• Press

to clear the message and continue printing.

to clear the message and continue printing.

The printer manually overrides the request, and then prints from an automatically selected tray.

• Press

, and then press

to cancel the print job.
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Remove paper from standard output bin
Remove the stack of paper from the standard exit bin.

Remove packaging material
Check for and remove any packaging materials from the toner cartridges.

Unsupported USB device, please remove
Remove the unrecognized USB device.

Unsupported USB hub, please remove
Remove the unrecognized USB hub.

Unplug and change mode
Make sure that the camera is in a valid mode for PictBridge

30 <color> Toner Cart Missing
Insert the missing toner cartridge to clear the message and continue printing. If the message appears again, remove
the cartridge, and then insert it until it clicks into place.

31.yy Defective <color> Cartridge
Try one or more of the following:

•
•
•
•

Open and close the top cover.
Remove the specified toner cartridge, and then insert it until it clicks into place.
Turn the printer off, wait ten seconds, and then turn the printer on.
Replace the specified toner cartridge with a new one.

31.yy Defective Imaging Kit
Try one or more of the following:

•
•
•
•

Open and close the top cover.
Remove the imaging kit, and then insert it until it clicks into place.
Turn the printer off, wait ten seconds, and then turn the printer on.
Replace the defective imaging kit with a new one.

31.yy Replace black and color imaging kit
Replace the black and color imaging kit.
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32.yy Replace Unsupported <color> Cartridge
Replace the unsupported toner cartridge with a supported one.

34 Short paper
The paper in the selected tray is too short for the current print job.
Try one or more of the following:

•
•
•
•

Load the appropriate paper in the tray.
Press the arrow buttons until Continue appears, and then press

to clear the message and continue printing.

Check tray length and width guides and make sure the paper is properly loaded in the tray.
For Windows users, check the Print Properties settings to make sure the print job is requesting the correct paper
size and type.
For Macintosh users, check the Print dialog settings to make sure the print job is requesting the correct paper size
and type.

• Check that the paper size is correctly set. For example, if the MP Feeder Size is set to Universal, make sure the paper
is large enough for the data being printed.

• Cancel the current print job.

35 Insufficient memory to support Resource Save feature
The printer lacks sufficient memory to save settings. Install additional memory, or press
clear the message, and continue printing.

to disable Resource Save,

37 Insufficient memory to collate job
Try one or more of the following:

• Press the arrow buttons until Continue appears, and then press

to print the portion of the job already stored

and begin collating the rest of the print job.

• Cancel the current print job.

37 Insufficient memory for Flash Memory Defragment operation
Try one or more of the following:

• Press the arrow buttons until Continue appears, and then press

to stop the defragment operation and

continue printing.

• Delete fonts, macros, and other data in printer memory.
• Install additional printer memory.

38 Memory full
Try one or more of the following:

• Press the arrow buttons until Continue appears, and then press
• Cancel the current print job.

to clear the message.
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• Install additional printer memory.

39 Complex page, some data may not have printed
Try one or more of the following:

• Press the arrow buttons until Continue appears, and then press
• Cancel the current print job.
• Install additional printer memory.

to clear the message and continue printing.

51 Defective flash detected
Try one or more of the following:

• Replace the defective flash memory card.
• Press the arrow buttons until Continue appears, and then press

to clear the message and continue printing.

52 Not enough free space in flash memory for resources
Try one or more of the following:

•
•
•
•

Press

to clear the message and continue printing.

Delete fonts, macros, and other data stored in flash memory.
Upgrade to a larger capacity flash memory.
Press

, and then press

to cancel printing.

53 Unformatted flash detected
Try one or more of the following:

• Press the arrow buttons until Continue appears, and then press
to continue printing.
• Format the flash memory. If the error message remains, the flash memory may be defective and require replacing.

54 Standard network software error
The printer detects unformatted flash memory when the power is turned on.
Try one or more of the following:

•
•
•
•

Press

to clear the message and continue printing.

Turn the power off and then back on to reset the printer.
Upgrade (flash) the network firmware in the printer or print server.
Format the flash memory. If the error message remains, the flash memory may be defective and require replacing.

54 Standard <x> software error
The printer detects that a network port is installed, but cannot communicate with it. The printer disables all
communication to the associated network interface.
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Try one or more of the following:

• Press
to clear the message and continue printing.
• Turn the power off and then back on to reset the printer.
• Upgrade (flash) the network firmware in the printer or print server.

56 Standard USB port disabled
Try one or more of the following:

• The printer discards any data received through the USB port. Press
• Make sure the USB Buffer menu item is not set to Disabled.

to clear the message and continue printing.

58 Too many flash options installed
Try one or more of the following:

• Turn the printer off, and then remove extra flash options:
1 Turn the printer off.
2 Unplug the power cord from the wall outlet.
3 Remove the excess flash memory.
4 Connect the power cord to a properly grounded outlet.
5 Turn the printer back on.
• Press
to clear the message and continue printing.

58 Too many trays attached
1 Turn the printer off.
2 Unplug the power cord from the wall outlet.
Note: Optional trays lock together when stacked. Remove stacked trays one at a time from the top down.

3 Remove the additional tray(s).
4 Connect the power cord to a properly grounded outlet.
5 Turn the printer back on.

59 Incompatible tray <x>
Only options designed specifically for this printer are supported.
Try one or more of the following:

• Remove the specified tray.
• Press the arrow buttons until Continue appears, and then press
without using the specified tray.

to clear the message and continue printing
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82 Replace waste toner box
Replace the waste toner bottle, and then press

to clear the message.

82 Waste toner box missing
Replace the waste toner bottle, and then press

to clear the message.

82 Waste toner box nearly full
Press

to clear the message.

88 Cartridge is low
Press

to clear the message.

88 Replace <color> cartridge
The specified toner cartridge is exhausted.

1 Replace the specified toner cartridge.
2 Touch Continue to clear the message and continue printing.

Solving basic printer problems
If there are basic printer problems, or the printer is unresponsive, make sure:

•
•
•
•
•
•

The power cord is plugged into the printer and a properly grounded electrical outlet.
The electrical outlet is not turned off by any switch or breaker.
The printer is not plugged into any surge protectors, uninterrupted power supplies, or extension cords.
Other electronic equipment plugged into the outlet is working.
The printer is turned on. Check the printer power switch.
The printer cable is securely attached to the printer and the host computer, print server, option, or other network
device.

• All options are properly installed.
• The printer driver settings are correct.
Once you have checked each of these possibilities, turn the printer off, wait for about 10 seconds, and then turn the
printer back on. This often fixes the problem.

Solving printing problems
Printer control panel display is blank or displays only diamonds
The printer self test failed. Turn the printer off, wait about 10 seconds, and then turn the printer back on.
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If Ready does not appear, turn the printer off and contact Customer Support.

Error message about reading USB drive appears
Make sure the USB drive is supported.

Jobs do not print
These are possible solutions. Try one or more of the following:

MAKE SURE THE PRINTER IS READY TO PRINT
Make sure Ready or Power Saver appears on the display before sending a job to print.

CHECK TO SEE IF THE STANDARD EXIT BIN IS FULL
Remove the stack of paper from the standard exit bin.

CHECK TO SEE IF THE PAPER TRAY IS EMPTY
Load paper in the tray.

MAKE SURE THE CORRECT PRINTER SOFTWARE IS INSTALLED
• Verify that you are using the correct printer software.
• If you are using a USB port, make sure you are running a supported operating system and using compatible printer
software.

MAKE SURE THE INTERNAL PRINT SERVER IS INSTALLED PROPERLY AND WORKING
• Make sure the internal print server is properly installed and that the printer is connected to the network.
• Print a network setup page and check that the status shows Connected. If the status is Not Connected, check the
network cables, and then try printing the network setup page again. Contact your system support person to make
sure the network is functioning correctly.
Copies of the printer software are also available on the Lexmark Web site at http://support.lexmark.com.

MAKE SURE YOU ARE USING A RECOMMENDED USB, SERIAL, OR ETHERNET CABLE
For more information, visit the Lexmark Web site at http://support.lexmark.com.

MAKE SURE PRINTER CABLES ARE SECURELY CONNECTED
Check the cable connections to the printer and print server to make sure they are secure.
For more information, see the setup documentation that came with the printer.
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Job takes longer than expected to print
These are possible solutions. Try one or more of the following:

REDUCE THE COMPLEXITY OF THE PRINT JOB
Eliminate the number and size of fonts, the number and complexity of images, and the number of pages in the job.

CHANGE THE PAGE PROTECT SETTING TO OFF
1 From the printer control panel, press

.

2 Press the arrow buttons until Settings appears, and then press

.

3 Press the arrow buttons until Setup Menu appears, and then press

.

4 Press the arrow buttons until Print Recovery appears, and then press
5 Press the arrow buttons until Page Protect appears, and then press
6 Press the arrow buttons until Off appears, and then press

.
.

.

Job prints from the wrong tray or on the wrong paper
CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Type setting.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

Incorrect characters print
MAKE SURE THE PRINTER IS NOT IN HEX TRACE MODE
If Ready Hex appears on the display, then you must exit Hex Trace mode before you can print your job. Turn the
printer off and back on to exit Hex Trace mode.

Tray linking does not work
These are possible solutions. Try one or more of the following:

LOAD THE SAME SIZE AND TYPE OF PAPER
• Load the same size and type of paper in each tray to be linked.
• Move the paper guides to the correct positions for the paper size loaded in each tray.
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USE THE SAME PAPER SIZE AND PAPER TYPE SETTINGS
• Print a menu settings page and compare the settings for each tray.
• If necessary, adjust the settings from the Paper Size/Type menu.
Note: The multipurpose feeder does not automatically sense the paper size. You must set the size from the Paper
Size/Type menu.

Large jobs do not collate
These are possible solutions. Try one or more of the following:

MAKE SURE COLLATE IS SET TO ON
From the Finishing menu or Print Properties, set Collate to On.
Note: Setting Collate to Off in the software overrides the setting in the Finishing menu.

REDUCE THE COMPLEXITY OF THE PRINT JOB
Reduce the complexity of the print job by eliminating the number and size of fonts, the number and complexity of
images, and the number of pages in the job.

MAKE SURE THE PRINTER HAS ENOUGH MEMORY
Add printer memory or an optional hard disk.

Unexpected page breaks occur
Increase the Print Timeout value:

1 From the printer control panel, press

.

2 Press the arrow buttons until Settings appears, and then press

.

3 Press the arrow buttons until General Settings appears, and then press
4 Press the arrow buttons until Timeouts appears, and then press

.

5 Press the arrow buttons until Print Timeout appears, and then press
6 Press the arrow buttons until the desired value appears, and then press

.
.

.
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Solving option problems
Settings chosen from the software program or application can change or override settings chosen from the printer
control panel. If an option is not functioning, then make sure it is selected in the software as well as the printer control
panel.

Option does not operate correctly or quits after it is installed
These are possible solutions. Try one or more of the following:

RESET THE PRINTER
Turn the printer off, wait for about 10 seconds, and then turn the printer on.

CHECK TO SEE IF THE OPTION IS CONNECTED TO THE PRINTER
1 Turn the printer off.
2 Unplug the printer from the wall outlet.
3 Check the connection between the option and the printer.

MAKE SURE THE OPTION IS INSTALLED
Print a menu settings page and check to see if the option is listed in the Installed Options list. If the option is not
listed, reinstall it.

MAKE SURE THE OPTION IS SELECTED
From the program you are using, select the option. Mac OS 9 users should make sure the printer is set up in the
Chooser.

Paper trays
These are possible solutions. Try one or more of the following:

MAKE SURE THE PAPER IS LOADED CORRECTLY
1 Open the paper tray.
2 Check for paper jams or misfeeds.
3 Make sure paper guides are aligned against the edges of the paper.
4 Make sure the paper tray closes properly.

RESET THE PRINTER
Turn the printer off, wait about 10 seconds, and then turn the printer on.
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MAKE SURE THE PAPER TRAY IS INSTALLED CORRECTLY
If the paper tray is listed on the menu settings page, but paper jams when it enters or exits the tray, then it may not
be properly installed. Reinstall the paper tray. For more information, see the hardware setup documentation that
came with the paper tray, or go to http://support.lexmark.com to view the paper tray instruction sheet.

Memory card
Make sure the memory card is securely connected to the printer system board.

Flash memory card
Make sure the flash memory card is securely connected to the printer system board.

Multipurpose feeder
These are possible solutions. Try one or more of the following:

CHECK THE MULTIPURPOSE FEEDER
Make sure the 650‑sheet duo drawer (multipurpose feeder) is installed properly.

CLEAR ANY JAMS
Clear any jams in the multipurpose feeder.

CHECK THE POWER CORD CONNECTION
Make sure:

• The power cord is plugged into the printer and a properly grounded electrical outlet.
• The outlet has power.

CHECK THE PAPER
Use recommended paper and specialty media. For more information, see “Paper and specialty media guidelines” on
page 46.

CHECK THE PAPER GUIDES
Move the guides in the tray to the correct position for the size loaded.

CHECK FOR SERVICE MESSAGES
If a service message appears, turn the printer off, wait about 10 seconds, and then turn the printer back on. If the
error recurs, then call for service. You may have a printer part that requires adjustment or replacement.
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Solving paper feed problems
Paper frequently jams
These are possible solutions. Try one or more of the following:

CHECK THE PAPER
Use recommended paper and specialty media. For more information, see “Paper and specialty media guidelines” on
page 46.

MAKE SURE THERE IS NOT TOO MUCH PAPER IN THE PAPER TRAY
Make sure the stack of paper you load does not exceed the maximum stack height indicated in the tray or on the
multipurpose feeder.

CHECK THE PAPER GUIDES
Move the guides in the tray to the correct positions for the paper size loaded.

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY
• Load paper from a fresh package.
• Store paper in its original wrapper until you use it.

Paper jam message remains after jam is cleared
1 Clear jammed paper from the entire paper path.
2 Press

to clear the message and continue printing.

Page that jammed does not reprint after you clear the jam
In the Setup menu, Jam Recovery is set to Off. Set Jam Recovery to Auto or On:

1 Press

.

2 Press the arrow buttons until Settings appears, and then press

.

3 Press the arrow buttons until General settings appears, and then press
4 Press the arrow buttons until Print Recovery appears, and then press
5 Press the arrow buttons until Jam Recovery appears, and then press
6 Press the arrow buttons until On or Auto appears, and then press

.

.
.

.
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Solving print quality problems
Isolating print quality problems
To help isolate print quality problems, print the print quality test pages:

1 Turn the printer off.
2 From the printer control panel, press and hold

and the right arrow button while turning the printer on.

3 Release both buttons when the clock animation appears.
The printer performs its power‑on sequence, and then Config Menu appears.

4 Press the arrow buttons until Prt Quality Pgs appears, and then press

.

The pages are formatted, Printing Quality Test Pages appears, and then the pages print. The message
remains on the display until all the pages print.

5 After the print quality test pages print, press the arrow buttons until Exit Config Menu appears, and then
press

.

The information in the following topics may help you solve print quality problems. If these suggestions still do not
correct the problem, then call for service. You may have a printer part that requires adjustment or replacement.

Blank pages

These are possible solutions. Try one or more of the following:

PACKING MATERIAL MAY BE ON THE TONER CARTRIDGE
Remove the toner cartridge and make sure the packing material is properly removed. Reinstall the toner cartridge.

THE TONER MAY BE LOW
When 88 Cartridge Low appears, order a new toner cartridge.
If the problem continues, the printer may need to be serviced. For more information, contact Customer Support.
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Clipped images
Try one or more of the following:

CHECK THE GUIDES
Move the width and length guides in the tray to the correct positions for the paper size loaded.

CHECK THE PAPER SIZE SETTING
Make sure the paper size setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Size setting.
2 Before sending the job to print, specify the correct size setting:
• For Windows users, specify the size from Print Properties.
• For Macintosh users, specify the size from the Page Setup dialog.

Characters have jagged or uneven edges

These are possible solutions. Try one or more of the following:

CHECK THE PRINT QUALITY SETTINGS
• Change the Print Resolution setting in the Quality menu to 600 dpi, 1200 Image Q, 1200 dpi, or 2400 Image Q.
• Enable Enhance Fine Lines in the Quality menu.

MAKE SURE DOWNLOADED FONTS ARE SUPPORTED
If you are using downloaded fonts, then verify that the fonts are supported by the printer, the host computer, and
the software program.
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Dark lines

ABCDE
ABCDE
ABCDE
The imaging kit may be defective.
If Black and color imaging kit life warning orBlack imaging kit life warning appears,
replace the imaging kit.

Gray background

ABCDE
ABCDE
ABCDE
CHECK THE TONER DARKNESS SETTING
Select a lighter Toner Darkness setting:

• From the printer control panel Quality menu, change the setting.
• For Windows users, change the setting from Print Properties.
• For Macintosh users, change the setting from the Print dialog.

Incorrect margins

ABCD
ABCD
ABCD
These are possible solutions. Try one or more of the following:

CHECK THE PAPER GUIDES
Move the guides in the tray to the correct positions for the paper size loaded.
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CHECK THE PAPER SIZE SETTING
Make sure the paper size setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Size setting.
2 Before sending the job to print, specify the correct size setting:
• For Windows users, specify the size from Print Properties.
• For Macintosh users, specify the size from the Page Setup dialog.

Light colored line, white line, or incorrectly colored line

These are possible solutions. Try one or more of the following:

A TONER CARTRIDGE MAY BE DEFECTIVE
Replace the defective toner cartridge.

THE IMAGING KIT MAY BE DEFECTIVE
Replace the imaging kit.
Note: The printer has two types of imaging kits: a black and color imaging kit, and a black imaging kit. The black
and color imaging kit contains cyan, magenta, yellow, and black. The black imaging kit contains black only.

Paper curl
These are possible solutions. Try one or more of the following:

CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Type setting.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

THE PAPER HAS ABSORBED MOISTURE DUE TO HIGH HUMIDITY
• Load paper from a fresh package.
• Store paper in its original wrapper until you use it.
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Print irregularities

These are possible solutions. Try one or more of the following:

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY
• Load paper from a fresh package.
• Store paper in its original wrapper until you use it.

CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Type setting.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

CHECK THE PAPER
Avoid textured paper with rough finishes.

THE TONER MAY BE LOW
When 88 <color> cartridge low appears or when the print becomes faded, replace the toner cartridge.

THE FUSER MAY BE WORN OR DEFECTIVE
Replace the fuser.
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Print is too dark

These are possible solutions. Try one or more of the following:

CALIBRATE THE COLOR
The printer automatically calibrates the colors whenever a new imaging kit is detected. If a cartridge is replaced, then
you can calibrate the colors manually:

1 From the printer control panel, press

.

2 From the Admin menu, press the arrow buttons until Settings appears, and then press
3 Press the arrow buttons until Quality menu appears, and then press

.

4 Press the arrow buttons until Color Adjust appears, and then press

.

.

Calibrating appears.

CHECK THE DARKNESS, BRIGHTNESS, AND CONTRAST SETTINGS
The Toner Darkness setting is too dark, the RGB Brightness setting is too dark, or the RGB Contrast setting is too high.

• For Windows users: from Print Properties, select Print Quality and then select More Print Quality Options to
change these settings.

• From the printer control panel Quality menu, change these settings.
• For Macintosh users:
1 Choose File > Print.
2 Locate the drop‑down box under the Orientation pictures, and then click the down button.
3 Click Printer Features.
4 Change the settings for Toner Darkness, Brightness, and Contrast.

THE PAPER HAS ABSORBED MOISTURE DUE TO HIGH HUMIDITY
• Load paper from a fresh package.
• Store paper in its original wrapper until you use it.

CHECK THE PAPER
Avoid textured paper with rough finishes.
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CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Type setting.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

THE IMAGING KIT MAY BE WORN OR DEFECTIVE
Replace the imaging kit.
Note: The printer has two types of imaging kits: a black and color imaging kit, and a black imaging kit. The black
and color imaging kit contains cyan, magenta, yellow, and black. The black imaging kit contains black only.

Print is too light

These are possible solutions. Try one or more of the following:

CALIBRATE THE COLOR
The printer automatically calibrates the colors whenever a new imaging kit is detected. If a cartridge is replaced, then
you can calibrate the colors manually:

1 From the printer control panel, press

.

2 From the Admin menu, press the arrow buttons until Settings appears, and then press
3 Press the arrow buttons until Quality menu appears, and then press

.

4 Press the arrow buttons until Color Adjust appears, and then press

.

.

Calibrating appears.

CHECK THE DARKNESS, BRIGHTNESS, AND CONTRAST SETTINGS
The Toner Darkness setting is too light, the RGB Brightness setting is too light, or the RGB Contrast setting is too low.

• For Windows users: from Print Properties, select Print Quality and then select More Print Quality Options to
change these settings.

• For Macintosh users:
1 Choose File > Print.
2 Locate the drop‑down box under the Orientation pictures, and then click the down button.
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3 Click Printer Features.
4 Change the settings for Toner Darkness, Brightness, and Contrast.
• From the printer control panel Quality menu, change these settings.

THE PAPER HAS ABSORBED MOISTURE DUE TO HIGH HUMIDITY
• Load paper from a fresh package.
• Store paper in its original wrapper until you use it.

CHECK THE PAPER
Avoid textured paper with rough finishes.

CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray.

1 From the printer control panel Paper menu, check the Paper Type setting.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

MAKE SURE COLOR SAVER IS SET TO OFF
Color Saver may be set to On.

THE TONER MAY BE LOW
When 88 <color> Cartridge Low appears or when the print becomes faded, replace the toner cartridge.

A TONER CARTRIDGE MAY BE DEFECTIVE
Replace the toner cartridge.

THE IMAGING KIT MAY BE WORN OR DEFECTIVE
Replace the imaging kit.
Note: The printer has two types of imaging kits: a black and color imaging kit, and a black imaging kit. The black
and color imaging kit contains cyan, magenta, yellow, and black. The black imaging kit contains black only.
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)

)

)

)

Repeating defects

REPEATING MARKS OCCUR REPEATEDLY ONLY IN ONE COLOR AND MULTIPLE TIMES ON A PAGE
Replace the developer unit if the defects occur every 43.9 mm (1.7 in.)
Replace the imaging kit if the defects occur every:

• 34.6 mm (1.4 in.)
• 94.2 mm (3.71 in.)
Notes:

• The printer has two types of imaging kits: a black and color imaging kit, and a black imaging kit. The black and
color imaging kit contains cyan, magenta, yellow, and black. The black imaging kit contains black only.

• The Print Defects menu prints a diagnostic list of problems. For more information, see “Menu Settings Page
menu” on page 71.

Skewed print
CHECK THE PAPER GUIDES
Move the guides in the tray to the correct positions for the paper size loaded.

CHECK THE PAPER
Make sure you are using paper that meets the printer specifications.

Solid color pages

The printer may need to be serviced. For more information, contact Customer Support.
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Toner fog or background shading appears on the page
These are possible solutions. Try one or more of the following:

THE IMAGING KIT MAY BE WORN OR DEFECTIVE
Replace the imaging kit.
Note: The printer has two types of imaging kits: a black and color imaging kit, and a black imaging kit. The black
and color imaging kit contains cyan, magenta, yellow, and black. The black imaging kit contains black only.

IS THERE TONER IN THE PAPER PATH?
Contact Customer Support.

Toner rubs off

These are possible solutions. Try one or more of the following:

CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Type setting from the Paper menu.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

CHECK THE PAPER TEXTURE SETTING
From the printer control panel Paper menu, make sure the Paper Texture setting matches the paper loaded in the
tray.
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Toner specks

These are possible solutions. Try one or more of the following:

THE IMAGING KIT MAY BE WORN OR DEFECTIVE
Replace the imaging kit.
Note: The printer has two types of imaging kits: a black and color imaging kit, and a black imaging kit. The black
and color imaging kit contains cyan, magenta, yellow, and black. The black imaging kit contains black only.

IS THERE TONER IN THE PAPER PATH?
Contact Customer Support.

Transparency print quality is poor
CHECK THE TRANSPARENCIES
Use only transparencies recommended by the printer manufacturer.

CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Type setting from the Paper menu.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.
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Uneven print density

ABCDE
ABCDE
ABCDE
Replace the black and color imaging kit.

Solving color quality problems
This section helps answer some basic color‑related questions and describes how some of the features provided in the
printer control panel Quality menu can be used to solve typical color problems.

Color misregistration

ABCDE
ABCDE
Color has shifted outside of the appropriate area or has been superimposed over another color area.
These are possible solutions. Try one or more of the following:

REMOVE AND REINSTALL THE TONER CARTRIDGES
Remove the toner cartridges, and then reinstall them.

CALIBRATE THE COLOR
The printer will automatically calibrate the colors whenever a new imaging kit is detected. If a cartridge is replaced,
then you can calibrate the colors manually:

1 From the printer control panel, press

.

2 From the Admin menu, press the arrow buttons until Settings appears, and then press
3 Press the arrow buttons until Quality menu appears, and then press

.

4 Press the arrow buttons until Color Adjust appears, and then press

.

Calibrating appears.
Note: If you have not resolved the issue, calibrate the color again.

.
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FAQ about color printing
What is RGB color?
Red, green, and blue light can be added together in various amounts to produce a large range of colors observed in
nature. For example, red and green can be combined to create yellow. Televisions and computer monitors create
colors in this manner. RGB color is a method of describing colors by indicating the amount of red, green, or blue
needed to produce a certain color.
What is CMYK color?
Cyan, magenta, yellow, and black inks or toners can be printed in various amounts to produce a large range of colors
observed in nature. For example, cyan and yellow can be combined to create green. Printing presses, inkjet printers,
and color laser printers create colors in this manner. CMYK color is a method of describing colors by indicating the
amount of cyan, magenta, yellow, and black needed to reproduce a particular color.
How is color specified in a document to be printed?
Software programs typically specify document color using RGB or CMYK color combinations. Additionally, they allow
users to modify the color of each object in a document. For more information, see the software program Help topics.
How does the printer know what color to print?
When a user prints a document, information describing the type and color of each object is sent to the printer. The
color information is passed through color conversion tables that translate the color into the appropriate amounts of
cyan, magenta, yellow, and black toner needed to produce the desired color. The object information determines the
application of color conversion tables. For example, it is possible to apply one type of color conversion table to text
while applying a different color conversion table to photographic images.
Should I use PostScript or PCL emulation printer software? What settings should I use for the best color?
The PostScript driver is strongly recommended for best color quality. The default settings in the PostScript driver
provide the preferred color quality for the majority of printouts.
Why doesn't the printed color match the color I see on the computer screen?
The color conversion tables used in Auto Color Correction mode generally approximate the colors of a standard
computer monitor. However, because of technology differences that exist between printers and monitors, there are
many colors that can also be affected by monitor variations and lighting conditions. For recommendations on how
the printer color sample pages may be useful in solving certain color‑matching problems, see the question, “How
can I match a particular color (such as a corporate logo)?”
The printed page appears tinted. Can I adjust the color?
Sometimes a printed page may appear tinted (for example, everything printed seems to be too red). This can be
caused by environmental conditions, paper type, lighting conditions, or user preference. In these instances, adjust
the Color Balance setting to create a more preferable color. Color Balance provides the user with the ability to make
subtle adjustments to the amount of toner being used in each color plane. Selecting positive or negative values for
cyan, magenta, yellow, and black (from the Color Balance menu) will slightly increase or decrease the amount of
toner used for the chosen color. For example, if a printed page has a red tint, then decreasing both magenta and
yellow could potentially improve the color balance.
My color transparencies seem dark when they are projected. Is there anything I can do to improve the color?
This problem most commonly occurs when projecting transparencies with reflective overhead projectors. To obtain
the highest projected color quality, transmissive overhead projectors are recommended. If a reflective projector
must be used, then adjusting the Toner Darkness setting to 1, 2, or 3 will lighten the transparency. Make sure to print
on the recommended type of color transparencies.
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What is manual color correction?
When manual color correction is enabled, the printer employs user‑selected color conversion tables to process
objects. However, Color Correction must be set to Manual, or no user‑defined color conversion will be implemented.
Manual color correction settings are specific to the type of object being printed (text, graphics, or images), and how
the color of the object is specified in the software program (RGB or CMYK combinations).
Notes:

• Manual color correction is not useful if the software program does not specify colors with RGB or CMYK
combinations. It is also not effective in situations in which the software program or the computer operating
system controls the adjustment of colors.

• The color conversion tables—applied to each object when Color Correction is set to Auto—generate preferred
colors for the majority of documents.
To manually apply a different color conversion table:

1 From the Quality menu, select Color Correction, and then select Manual.
2 From the Quality menu, select Manual Color, and then select the appropriate color conversion table for the
affected object type.

Manual Color menu
Object type
RGB Image
RGB Text
RGB Graphics

Color conversion tables

• Vivid—Produces brighter, more saturated colors and may be applied
to all incoming color formats.

• sRGB Display—Produces an output that approximates the colors
displayed on a computer monitor. Black toner usage is optimized for
printing photographs.

• Display—True Black—Produces an output that approximates the
colors displayed on a computer monitor. Uses only black toner to create
all levels of neutral gray.

• sRGB Vivid—Provides an increased color saturation for the sRGB
Display color correction. Black usage is optimized for printing business
graphics.

• Off—No color correction is implemented.
CMYK Image
CMYK Text
CMYK Graphics

• US CMYK—Applies color correction to approximate the SWOP
(Specifications for Web Offset Publishing) color output.

• Euro CMYK—Applies color correction to approximated EuroScale color
output.

• Vivid CMYK—Increases the color saturation of the US CMYK color
correction setting.

• Off—No color correction is implemented.
How can I match a particular color (such as a corporate logo)?
From the printer Quality menu, nine types of Color Samples sets are available. These are also available from the Color
Samples page of the Embedded Web Server. Selecting any sample set generates a multiple‑page printout consisting
of hundreds of colored boxes. Either a CMYK or RGB combination is located on each box, depending on the table
selected. The observed color of each box is obtained by passing the CMYK or RGB combination labeled on the box
through the selected color conversion table.
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By examining Color Samples sets, a user can identify the box whose color is the closest to the desired color. The color
combination labeled on the box can then be used for modifying the color of the object in a software program. For
more information, see the software program Help topics. Manual color correction may be necessary to utilize the
selected color conversion table for the particular object.
Selecting which Color Samples set to use for a particular color‑matching problem depends on the Color Correction
setting being used (Auto, Off, or Manual), the type of object being printed (text, graphics, or images), and how the
color of the object is specified in the software program (RGB or CMYK combinations). When the printer Color
Correction setting is set to Off, the color is based on the print job information; and no color conversion is implemented.
Note: The Color Samples pages are not useful if the software program does not specify colors with RGB or CMYK
combinations. Additionally, certain situations exist in which the software program or the computer operating
system adjusts the RGB or CMYK combinations specified in the program through color management. The resulting
printed color may not be an exact match of the Color Samples pages.
What are detailed Color Samples and how do I access them?
Detailed Color Samples sets are available only through the Embedded Web Server of a network printer. A detailed
Color Samples set contains a range of shades (displayed as colored boxes) that are similar to a user‑defined RGB or
CMYK value. The likeness of the colors in the set are dependent on the value entered in the RGB or CMYK Increment
box.
To access a detailed Color Samples set from the Embedded Web Server:

1 Open a Web browser.
2 In the address bar, type the network printer IP address.
3 Click Configuration.
4 Click Color Samples.
5 Click Detailed Options to narrow the set to one color range.
6 When the Detailed Options page appears, select a color conversion table.
7 Enter the RGB or CMYK color number.
8 Enter an Increment value from 1–255.
Note: The closer the value is to 1, the narrower the color sample range will appear.

9 Click Print to print the detailed Color Samples set.

Contacting Customer Support
When you call Customer Support, describe the problem you are experiencing, the message on the display, and the
troubleshooting steps you have already taken to find a solution.
You need to know your printer model type and serial number. For more information, see the label on the inside top
front cover of the printer. The serial number is also listed on the menu settings page.
In the U.S. or Canada, call 1‑800‑539‑6275. For other countries or regions, visit the Lexmark Web site at
http://support.lexmark.com.
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Notices
Product information
Product name:
Lexmark C540n, C543dn, C544n, C544dn, C544dw, C546dtn
Machine type:
5025
Model(s):
210, 230, 410, 430, 43W, 439, n01, n02, dnw, xd1, xd2, dn1, dn2, gd1, gd2, dw1, dw2, dt1, dt2, gt1, gt2

Edition notice
November 2012
The following paragraph does not apply to any country where such provisions are inconsistent with local law:
LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions; therefore, this statement may not apply to you.
This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the
information herein; these changes will be incorporated in later editions. Improvements or changes in the products or
the programs described may be made at any time.
References in this publication to products, programs, or services do not imply that the manufacturer intends to make
these available in all countries in which it operates. Any reference to a product, program, or service is not intended to
state or imply that only that product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification
of operation in conjunction with other products, programs, or services, except those expressly designated by the
manufacturer, are the user’s responsibility.
For Lexmark technical support, visit http://support.lexmark.com.
For information on supplies and downloads, visit www.lexmark.com.
© 2012 Lexmark International, Inc.
All rights reserved.

GOVERNMENT END USERS
The Software Program and any related documentation are "Commercial Items," as that term is defined in 48 C.F.R.
2.101, "Computer Software" and "Commercial Computer Software Documentation," as such terms are used in 48 C.F.R.
12.212 or 48 C.F.R. 227.7202, as applicable. Consistent with 48 C.F.R. 12.212 or 48 C.F.R. 227.7202-1 through 227.7207-4,
as applicable, the Commercial Computer Software and Commercial Software Documentation are licensed to the U.S.
Government end users (a) only as Commercial Items and (b) with only those rights as are granted to all other end users
pursuant to the terms and conditions herein.
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Trademarks
Lexmark, Lexmark with diamond design, and MarkVision are trademarks of Lexmark International, Inc., registered in
the United States and/or other countries.
Mac and the Mac logo are trademarks of Apple Inc., registered in the U.S. and other countries.
PCL® is a registered trademark of the Hewlett-Packard Company. PCL is Hewlett-Packard Company’s designation of a
set of printer commands (language) and functions included in its printer products. This printer is intended to be
compatible with the PCL language. This means the printer recognizes PCL commands used in various application
programs, and that the printer emulates the functions corresponding to the commands.
All other trademarks are the property of their respective owners.

Federal Communications Commission (FCC) compliance information statement
This product has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause undesired operation.
The FCC Class B limits are designed to provide reasonable protection against harmful interference when the equipment
is operated in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the following measures:

•
•
•
•

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for radio or television interference caused by using other than recommended
cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could
void the user's authority to operate this equipment.
Note: To assure compliance with FCC regulations on electromagnetic interference for a Class B computing device,
use a properly shielded and grounded cable such as Lexmark part number 1021231 for parallel attach or 1021294 for
USB attach. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC
regulations.
Any questions regarding this compliance information statement should be directed to:
Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY 40550
(859) 232–3000

Modular component notice
Wireless‑equipped models contain the following modular component(s):
Lexmark regulatory type/model LEX-M04-001; FCC ID:IYLLEXM04001; IC:2376A-M04001
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Noise emission levels
The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.
Note: Some modes may not apply to your product.
1-meter average sound pressure, dBA
Printing

48 dBA

Ready

Inaudible

Values are subject to change. See www.lexmark.com for current values.

Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European
Union. We encourage the recycling of our products. If you have further questions about recycling options, visit the
Lexmark Web site at www.lexmark.com for your local sales office phone number.

Static sensitivity notice

This symbol identifies static-sensitive parts. Do not touch in the areas near these symbols without first touching the
metal frame of the printer.
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ENERGY STAR
Any Lexmark product bearing the ENERGY STAR emblem on the product or on a start-up screen is certified to comply
with Environmental Protection Agency (EPA) ENERGY STAR requirements as configured when shipped by Lexmark.

Temperature information
Ambient temperature

15.6-32.2°C (60-90°F)

Shipping and storage temperature

-40-43.3°C (-40-110°F)

Laser notice
The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR Subchapter J for Class I (1) laser
products, and elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1.
Class I laser products are not considered to be hazardous. The printer contains internally a Class IIIb (3b) laser that is
nominally a 7 milliwatt gallium arsenide laser operating in the wavelength of 655-675 nanometers. The laser system
and printer are designed so there is never any human access to laser radiation above a Class I level during normal
operation, user maintenance, or prescribed service condition.

Laser advisory label
A laser notice label may be affixed to this printer as shown:
DANGER - Invisible laser radiation when cartridges are removed and interlock defeated. Avoid exposure to laser beam.
PERIGO - Radiação a laser invisível será liberada se os cartuchos forem removidos e o lacre rompido. Evite a exposição aos feixes de laser.
Opasnost - Nevidljivo lasersko zračenje kada su kasete uklonjene i poništena sigurnosna veza. Izbjegavati izlaganje zracima.
NEBEZPEČÍ - Když jsou vyjmuty kazety a je odblokována pojistka, ze zařízení je vysíláno neviditelné laserové záření. Nevystavujte se působení laserového paprsku.
FARE - Usynlig laserstråling, når patroner fjernes, og spærreanordningen er slået fra. Undgå at blive udsat for laserstrålen.
GEVAAR - Onzichtbare laserstraling wanneer cartridges worden verwijderd en een vergrendeling wordt genegeerd. Voorkom blootstelling aan de laser.
DANGER - Rayonnements laser invisibles lors du retrait des cartouches et du déverrouillage des loquets. Eviter toute exposition au rayon laser.
VAARA - Näkymätöntä lasersäteilyä on varottava, kun värikasetit on poistettu ja lukitus on auki. Vältä lasersäteelle altistumista.
GEFAHR - Unsichtbare Laserstrahlung beim Herausnehmen von Druckkassetten und offener Sicherheitssperre. Laserstrahl meiden.
ΚΙΝΔΥΝΟΣ - Έκλυση αόρατης ακτινοβολίας laser κατά την αφαίρεση των κασετών και την απασφάλιση της μανδάλωσης. Αποφεύγετε την έκθεση στην ακτινοβολία laser.
VESZÉLY – Nem látható lézersugárzás fordulhat elő a patronok eltávolításakor és a zárószerkezet felbontásakor. Kerülje a lézersugárnak való kitettséget.
PERICOLO - Emissione di radiazioni laser invisibili durante la rimozione delle cartucce e del blocco. Evitare l´esposizione al raggio laser.
FARE – Usynlig laserstråling når kassettene tas ut og sperren er satt ut av spill. Unngå eksponering for laserstrålen.
NIEBEZPIECZEŃSTWO - niewidzialne promieniowanie laserowe podczas usuwania kaset i blokady. Należy unikać naświetlenia promieniem lasera.
ОПАСНО! Невидимое лазерное излучение при извлеченных картриджах и снятии блокировки. Избегайте воздействия лазерных лучей.
Pozor – Nebezpečenstvo neviditeľného laserového žiarenia pri odobratých kazetách a odblokovanej poistke. Nevystavujte sa lúčom.
PELIGRO: Se producen radiaciones láser invisibles al extraer los cartuchos con el interbloqueo desactivado. Evite la exposición al haz de láser.
FARA – Osynlig laserstrålning när patroner tas ur och spärrmekanismen är upphävd. Undvik exponering för laserstrålen.
危险 - 当移除碳粉盒及互锁失效时会产生看不见的激光辐射，请避免暴露在激光光束下。
危險 - 移除碳粉匣與安全連續開關失效時會產生看不見的雷射輻射。請避免曝露在雷射光束下。
危険 - カートリッジが取り外され、内部ロックが無効になると、見えないレーザー光が放射されます。 このレーザー光に当たらないようにしてください。
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Power consumption
Product power consumption
The following table documents the power consumption characteristics of the product.
Note: Some modes may not apply to your product.
Mode

Description

Power consumption (Watts)

Printing

The product is generating hard‑copy output from electronic inputs. 480 W (C540, C543); 500 W (C544, C546)

Copying

The product is generating hard‑copy output from hard‑copy
original documents.

N/A

Scanning

The product is scanning hard‑copy documents.

N/A

Ready

The product is waiting for a print job.

34 W (C540, C543); 36 W (C544, C546)

Power Saver The product is in energy‑saving mode.
Off

<18 W (C540); <16 W (C543, C544, C546)

The product is plugged into a wall outlet, but the power switch is 0 W
turned off.

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous
power draws may be substantially higher than the average.
Values are subject to change. See www.lexmark.com for current values.

Power Saver
This product is designed with an energy-saving mode called Power Saver. The Power Saver Mode is equivalent to the
Sleep Mode. The Power Saver Mode saves energy by lowering power consumption during extended periods of inactivity.
The Power Saver Mode is automatically engaged after this product is not used for a specified period of time, called the
Power Saver Timeout.
Factory default Power Saver Timeout for this product (in minutes):

20 minutes (C540, C543); 30 minutes (C544, C546)

By using the configuration menus, the Power Saver Timeout can be modified between 1 minute and 240 minutes.
Setting the Power Saver Timeout to a low value reduces energy consumption, but may increase the response time of
the product. Setting the Power Saver Timeout to a high value maintains a fast response, but uses more energy.

Off mode
If this product has an off mode which still consumes a small amount of power, then to completely stop product power
consumption, disconnect the power supply cord from the wall outlet.

Total energy usage
It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in
power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in
order to calculate energy usage. The total product energy usage is the sum of each mode's energy usage.
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Industry Canada compliance statement
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Standard
ICES-003.

Avis de conformité aux normes de l’industrie du Canada
Cet appareil numérique de classe B est conforme aux exigences de la norme canadienne relative aux équipements
pouvant causer des interférences NMB-003.

European Community (EC) directives conformity
This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC and
2009/125/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic
compatibility, safety of electrical equipment designed for use within certain voltage limits and the ecodesign of energyrelated products.
The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.
This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Regulatory notices for wireless products
This section contains the following regulatory information pertaining to wireless products that contain transmitters,
for example, but not limited to, wireless network cards or proximity card readers.

Exposure to radio frequency radiation
The radiated output power of this device is far below the radio frequency exposure limits of the FCC and other regulatory
agencies. A minimum separation of 20 cm (8 inches) must be maintained between the antenna and any persons for
this device to satisfy the RF exposure requirements of the FCC and other regulatory agencies.

Industry Canada (Canada)
This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that
may cause undesired operation of the device.
This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly prohibited
per regulations of Industry Canada.
To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.
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The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit RF
fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health
Canada's Web site www.hc-sc.gc.ca/rpb.
The term "IC:" before the certification/registration number only signifies that the Industry Canada technical
specifications were met.

Industry Canada (Canada)
Cet appareil est conforme à la norme RSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions
suivantes :
(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence reçue, y compris celles
risquant d'altérer son fonctionnement.
Cet appareil a été conçu pour fonctionner uniquement avec l'antenne fournie. L'utilisation de toute autre antenne est
strictement interdite par la réglementation d'Industry Canada.
En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est strictement
interdite.
Pour empêcher toute interférence radio au service faisant l'objet d'une licence, cet appareil doit être utilisé à l'intérieur
et loin des fenêtres afin de garantir une protection optimale.
Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.
L'installateur de cet équipement radio doit veiller à ce que l'antenne soit implantée et dirigée de manière à n'émettre
aucun champ HF dépassant les limites fixées pour l'ensemble de la population par Santé Canada. Reportez-vous au
Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.
Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme
aux spécifications techniques d'Industry Canada.

Notice to users in the European Union
This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC,
1999/5/EC, and 2009/125/EC on the approximation and harmonization of the laws of the Member States relating to
electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits, radio
equipment and telecommunications terminal equipment and on the ecodesign of energy-related products.
Compliance is indicated by the CE marking.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.
This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.
Products equipped with 2.4GHz Wireless LAN option are in conformity with the protection requirements of EC Council
directives 2004/108/EC, 2006/95/EC, 1999/5/EC, and 2009/125/EC on the approximation and harmonization of the
laws of the Member States relating to electromagnetic compatibility, safety of electrical equipment designed for use
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within certain voltage limits and on radio equipment and telecommunications terminal equipment and on the ecodesign
of energy-related products.
Compliance is indicated by the CE marking.

Operation is allowed in all EU and EFTA countries, but is restricted to indoor use only.
The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.
This product may be used in the countries indicated in the table below.
AT

BE

BG

CH

CY

CZ

DE

DK

EE

EL

ES

FI

FR

HR

HU

IE

IS

IT

LI

LT

LU

LV

MT

NL

NO

PL

PT

RO

SE

SI

SK

TR

UK

Česky

Společnost Lexmark International, Inc. tímto prohlašuje, že výrobek tento výrobek je ve shodě se základními
požadavky a dalšími příslušnými ustanoveními směrnice 1999/5/ES.

Dansk

Lexmark International, Inc. erklærer herved, at dette produkt overholder de væsentlige krav og øvrige relevante
krav i direktiv 1999/5/EF.

Deutsch

Hiermit erklärt Lexmark International, Inc., dass sich das Gerät dieses Gerät in Übereinstimmung mit den
grundlegenden Anforderungen und den übrigen einschlägigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

Ελληνική

ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ Η LEXMARK INTERNATIONAL, INC. ΔΗΛΩΝΕΙ ΟΤΙ ΑΥΤΟ ΤΟ ΠΡΟΪΟΝ
ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ
ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.

English

Hereby, Lexmark International, Inc., declares that this type of equipment is in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC.

Español

Por medio de la presente, Lexmark International, Inc. declara que este producto cumple con los requisitos
esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.

Eesti

Käesolevaga kinnitab Lexmark International, Inc., et seade see toode vastab direktiivi 1999/5/EÜ
põhinõuetele ja nimetatud direktiivist tulenevatele muudele asjakohastele sätetele.

Suomi

Lexmark International, Inc. vakuuttaa täten, että tämä tuote on direktiivin 1999/5/EY oleellisten vaatimusten
ja muiden sitä koskevien direktiivin ehtojen mukainen.

Français

Par la présente, Lexmark International, Inc. déclare que l'appareil ce produit est conforme aux exigences
fondamentales et autres dispositions pertinentes de la directive 1999/5/CE.

Magyar

Alulírott, Lexmark International, Inc. nyilatkozom, hogy a termék megfelel a vonatkozó alapvetõ
követelményeknek és az 1999/5/EC irányelv egyéb elõírásainak.

Íslenska

Hér með lýsir Lexmark International, Inc. yfir því að þessi vara er í samræmi við grunnkröfur og aðrar
kröfur, sem gerðar eru í tilskipun 1999/5/EC.
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Italiano

Con la presente Lexmark International, Inc. dichiara che questo questo prodotto è conforme ai requisiti
essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Latviski

Ar šo Lexmark International, Inc. deklarē, ka šis izstrādājums atbilst Direktīvas 1999/5/EK būtiskajām
prasībām un citiem ar to saistītajiem noteikumiem.

Lietuvių

Šiuo Lexmark International, Inc. deklaruoja, kad šis produktas atitinka esminius reikalavimus ir kitas
1999/5/EB direktyvos nuostatas.

Malti

Bil-preżenti, Lexmark International, Inc., jiddikjara li dan il-prodott huwa konformi mal-ħtiġijiet
essenzjali u ma dispożizzjonijiet oħrajn relevanti li jinsabu fid-Direttiva 1999/5/KE.

Nederlands Hierbij verklaart Lexmark International, Inc. dat het toestel dit product in overeenstemming is met de essentiële
eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.
Norsk

Lexmark International, Inc. erklærer herved at dette produktet er i samsvar med de grunnleggende krav og
øvrige relevante krav i direktiv 1999/5/EF.

Polski

Niniejszym Lexmark International, Inc. oświadcza, że niniejszy produkt jest zgodny z zasadniczymi
wymogami oraz pozostałymi stosownymi postanowieniami Dyrektywy 1999/5/EC.

Português

A Lexmark International Inc. declara que este este produto está conforme com os requisitos essenciais e outras
disposições da Diretiva 1999/5/CE.

Slovensky Lexmark International, Inc. týmto vyhlasuje, že tento produkt spĺňa základné požiadavky a všetky
príslušné ustanovenia smernice 1999/5/ES.
Slovensko Lexmark International, Inc. izjavlja, da je ta izdelek v skladu z bistvenimi zahtevami in ostalimi
relevantnimi določili direktive 1999/5/ES.
Svenska

Härmed intygar Lexmark International, Inc. att denna produkt står i överensstämmelse med de väsentliga
egenskapskrav och övriga relevanta bestämmelser som framgår av direktiv 1999/5/EG.

STATEMENT OF LIMITED WARRANTY FOR LEXMARK LASER PRINTERS,
LEXMARK LED PRINTERS, AND LEXMARK MULTIFUNCTION LASER PRINTERS
Lexmark International, Inc., Lexington, KY
This limited warranty applies to the United States and Canada. For customers outside the U.S., refer to the countryspecific warranty information that came with your product.
This limited warranty applies to this product only if it was originally purchased for your use, and not for resale, from
Lexmark or a Lexmark Remarketer, referred to in this statement as “Remarketer.”

Limited warranty
Lexmark warrants that this product:
—Is manufactured from new parts, or new and serviceable used parts, which perform like new parts
—Is, during normal use, free from defects in material and workmanship
If this product does not function as warranted during the warranty period, contact a Remarketer or Lexmark for repair
or replacement (at Lexmark's option).
If this product is a feature or option, this statement applies only when that feature or option is used with the product
for which it was intended. To obtain warranty service, you may be required to present the feature or option with the
product.
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If you transfer this product to another user, warranty service under the terms of this statement is available to that user
for the remainder of the warranty period. You should transfer proof of original purchase and this statement to that
user.

Limited warranty service
The warranty period starts on the date of original purchase as shown on the purchase receipt and ends 12 months later
provided that the warranty period for any supplies and for any maintenance items included with the printer shall end
earlier if it, or its original contents, are substantially used up, depleted, or consumed. Fuser Units, Transfer/Transport
Units, Paper Feed items, if any, and any other items for which a Maintenance Kit is available are substantially consumed
when the printer displays a “Life Warning” or “Scheduled Maintenance” message for such item.
To obtain warranty service you may be required to present proof of original purchase. You may be required to deliver
your product to the Remarketer or Lexmark, or ship it prepaid and suitably packaged to a Lexmark designated location.
You are responsible for loss of, or damage to, a product in transit to the Remarketer or the Lexmark designated location.
When warranty service involves the exchange of a product or part, the item replaced becomes the property of the
Remarketer or Lexmark. The replacement may be a new or repaired item.
The replacement item assumes the remaining warranty period of the original product.
Replacement is not available to you if the product you present for exchange is defaced, altered, in need of a repair not
included in warranty service, damaged beyond repair, or if the product is not free of all legal obligations, restrictions,
liens, and encumbrances.
As part of your warranty service and/or replacement, Lexmark may update the firmware in your printer to the latest
version. Firmware updates may modify printer settings and cause counterfeit and/or unauthorized products, supplies,
parts, materials (such as toners and inks), software, or interfaces to stop working. Authorized use of genuine Lexmark
products will not be impacted.
Before you present this product for warranty service, remove all print cartridges, programs, data, and removable storage
media (unless directed otherwise by Lexmark).
For further explanation of your warranty alternatives and the nearest Lexmark authorized servicer in your area contact
Lexmark on the World Wide Web.
Remote technical support is provided for this product throughout its warranty period. For products no longer covered
by a Lexmark warranty, technical support may not be available or only be available for a fee.

Extent of limited warranty
Lexmark does not warrant uninterrupted or error-free operation of any product or the durability or longevity of prints
produced by any product.
Warranty service does not include repair of failures caused by:
—Modification or unauthorized attachments
—Accidents, misuse, abuse or use inconsistent with Lexmark user’s guides, manuals, instructions or guidance
—Unsuitable physical or operating environment
—Maintenance by anyone other than Lexmark or a Lexmark authorized servicer
—Operation of a product beyond the limit of its duty cycle
—Use of printing media outside of Lexmark specifications
—Refurbishment, repair, refilling or remanufacture by a third party of products, supplies or parts
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—Products, supplies, parts, materials (such as toners and inks), software, or interfaces not furnished by Lexmark
TO THE EXTENT PERMITTED BY APPLICABLE LAW, NEITHER LEXMARK NOR ITS THIRD PARTY SUPPLIERS OR
REMARKETERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH
RESPECT TO THIS PRODUCT, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND SATISFACTORY QUALITY. ANY WARRANTIES THAT
MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO
WARRANTIES, EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. ALL INFORMATION, SPECIFICATIONS, PRICES,
AND SERVICES ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE.

Limitation of liability
Your sole remedy under this limited warranty is set forth in this document. For any claim concerning performance or
nonperformance of Lexmark or a Remarketer for this product under this limited warranty, you may recover actual
damages up to the limit set forth in the following paragraph.
Lexmark's liability for actual damages from any cause whatsoever will be limited to the amount you paid for the product
that caused the damages. This limitation of liability will not apply to claims by you for bodily injury or damage to real
property or tangible personal property for which Lexmark is legally liable. IN NO EVENT WILL LEXMARK BE LIABLE FOR
ANY LOST PROFITS, LOST SAVINGS, INCIDENTAL DAMAGE, OR OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES.
This is true even if you advise Lexmark or a Remarketer of the possibility of such damages. Lexmark is not liable for any
claim by you based on a third party claim.
This limitation of remedies also applies to claims against any Suppliers and Remarketers of Lexmark. Lexmark's and its
Suppliers' and Remarketers' limitations of remedies are not cumulative. Such Suppliers and Remarketers are intended
beneficiaries of this limitation.

Additional rights
Some states do not allow limitations on how long an implied warranty lasts, or do not allow the exclusion or limitation
of incidental or consequential damages, so the limitations or exclusions contained above may not apply to you.
This limited warranty gives you specific legal rights. You may also have other rights that vary from state to state.

Patent acknowledgment
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Elliptic Curve Cryptography (ECC) Cipher Suites for Transport
Layer Security (TLS) implemented in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for TLS Elliptic Curve Cipher Suites with SHA-256/382 and AES Galois
Counter Mode (GCM) implemented in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for TLS Suite B Profile for Transport Layer Security (TLS) implemented
in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Addition of the Camellia Cipher Suites to Transport Layer Security
(TLS) implemented in the product or service.
The use of certain patents in this product or service is subject to the reasonable, non-discriminatory terms in the
Intellectual Property Rights (IPR) Disclosure of Certicom Corp. at the IETF for AES-CCM ECC Cipher Suites for TLS
implemented in the product or service.
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The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for IKE and IKEv2 Authentication Using the Eliptic Curve Digital
Signature Algorithm (ECDSA) implemented in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Suite B Cryptographic Suites for IPSec implemented in the
product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Algorithms for Internet Key Exchange version 1 (IKEv1)
implemented in the product or service.
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Index
Numerics

C

250‑sheet tray (standard)
loading 39
30.yy <color> Toner Cart
Missing 126
31.yy Defective Imaging Kit 126
31.yy Replace black and color
imaging kit 126
34 Short paper 127
35 Insufficient memory to support
Resource Save feature 127
37 Insufficient memory for Flash
Memory Defragment
operation 127
37 Insufficient memory to collate
job 127
38 Memory full 127
39 Complex page, some data may
not have printed 128
51 Defective flash detected 128
52 Not enough free space in flash
memory for resources 128
53 Unformatted flash detected 128
54 Standard <x> software error 128
54 Standard network software
error 128
550‑sheet tray
installing 19
56 Standard USB port disabled 129
58 Too many flash options
installed 129
58 Too many trays attached 129
59 Incompatible tray <x> 129
650‑sheet duo drawer
installing 19
loading 41
82 Replace waste toner box 130
82 Waste toner box missing 130
82 Waste toner box nearly full 130
88 Cartridge is low 130
88 Replace <color> cartridge 130

cables, attaching
Ethernet 20
USB 20
Calibrating 124
calling Customer Support 151
canceling
print job, from computer 60
canceling a job
from the printer control panel 60
canceling a print job
from a computer 60
card stock
loading 42
tips on using 57
checking an unresponsive
printer 130
cleaning
exterior of the printer 113
Close Door 124
configuration information
wireless network 24
configurations
printer 8
configuring
multiple printers 116
configuring supply notifications 116
conservation settings
Eco‑Mode 34
Quiet Mode 35
conserving supplies 33
contacting Customer Support 151
control panel, printer
factory defaults, restoring 115
Custom Types menu
printer menus 70

A
Active NIC menu 73
AppleTalk menu 77
Asset Report menu 72
attaching cables 20

D
Defective <color> Cartridge 126
developer unit
replacing 108
Device Statistics menu 72
directory list
printing 60
display troubleshooting
display is blank 130
display shows only diamonds 130
display, printer control panel 10

documents, printing
from Macintosh 53
from Windows 53

E
Eco‑Mode setting 34
Embedded Web Server 115
copying settings to other
printers 116
setting up e‑mail alerts 116
emission notices 153, 154, 157, 158
envelopes
loading 42, 44
tips 55
environmental settings 33
Eco‑Mode 34
Quiet Mode 35
Ethernet network setup
using Macintosh 29
using Windows 29
Ethernet networking
Macintosh 29
Windows 29
Ethernet port 20
exterior of the printer
cleaning 113
e‑mail
notice of low supply level 116
notice of paper jam 116
notice of paper needed 116
notice that different paper is
needed 116

F
factory defaults, restoring
printer control panel menus 115
FAQ about color printing 149
FCC notices 153, 157
finding more information about the
printer 6
Finishing menu 82
Flash drive menu 92
flash memory card
installing 17
troubleshooting 135
font sample list
printing 59

Index
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Image menu 91
imaging kit
replacing 100
imaging kits
ordering 95
Insert Tray <x> 124
installing on a wireless network
using Windows 25
installing printer
on wireless network 25
installing printer on a network
Ethernet networking 29
installing printer on a wireless
network
using Macintosh 26
installing printer software
adding options 23
installing printer software
(Windows) 22
IPv6 menu 76

letterhead
loading, manual feeder 53
loading, trays 53
tips on using 53
light, indicator 10
linking trays 37
Load <input src> with <custom
string> 124
Load <input src> with <custom type
name> 124
Load <input src> with <size> 124
Load <input src> with <type>
<size> 125
Load single sheet feeder with
<custom string> 125
Load single sheet feeder with
<custom type name> 125
Load single sheet feeder with
<size> 125
Load single sheet feeder with
<type> <size> 125
loading
250‑sheet tray (standard) 39
650‑sheet duo drawer 41
card stock 42
envelopes 42, 44
letterhead in manual feeder 53
letterhead in trays 53
manual feeder 44
multipurpose feeder 42
transparencies 42

J

M

G
General Settings menu 79
green settings
Quiet Mode 35
guidelines
card stock 57
envelopes 55
letterhead 53

I

jams
avoiding 118
locations 118
number codes 118
jams, clearing
200 119
201 119
202 119
230 119
231 122
235 122
24x 122
250 123

L
labels, paper
tips 56

manual feeder
loading 44
memory card
installing 15
troubleshooting 135
menu settings
loading on multiple printers 116
Menu Settings Page menu 71
menu settings page, printing 21
menus
Active NIC 73
Asset Report 72
Default Source 63
Device Statistics 72
diagram of 62
Finishing 82
Flash drive 92
General Settings 79
Image 91

IPv6 76
Menu Settings Page 71
Network 73
Network Card 74
Network Reports 74
Network Setup Page 72
Paper Loading 69
Paper Size/Type 63
Paper Texture 66
Paper Weight 68
PCL Emul 88
PDF 87
PictBridge 91
PostScript 88
Print Defects 72
Print Fonts 72
Quality 84
Setup 81
Supplies 62
TCP/IP 75
Universal Setup 71
USB 78
Utilities 87
Wireless 76
moving the printer 114
multipurpose feeder
loading 42

N
Network Card menu 74
Network menu 73
Network Reports menu 74
network setup page 22
Network Setup Page menu 72
noise emission levels 154
notices 153, 154, 155, 156, 157,
158, 159

O
options
550‑sheet tray 19
650‑sheet duo drawer 19
flash memory card 17
internal 12
memory card 15
memory cards 12
updating in printer driver 23
ordering
imaging kits 95
toner cartridges 94
waste toner bottle 96

Index

P
paper
capacities 52
characteristics 46
letterhead 47
preprinted forms 47
recycled 32
selecting 47
selecting weight 68
setting size 38
setting type 38
storing 47
unacceptable 32
Universal Paper Size 71
Universal size setting 38
paper feed troubleshooting
message remains after jam is
cleared 136
paper jams
avoiding 118
Paper Size/Type menu 63
paper sizes
supported by the printer 48
paper types
supported by printer 49
where to load 49
paper types and weights
supported by the printer 50
Paper Weight menu 68
PCL Emul menu 88
PDF menu 87
PictBridge‑enabled printing
photos 59
PostScript menu 88
Power Saver
adjusting 35
Print Defects menu 72
Print Fonts menu 72
print job
canceling from the printer control
panel 60
canceling, from computer 60
print quality
replacing developer unit 108
replacing imaging kit 100
replacing the waste toner box 97
print quality test pages, printing 60
print quality troubleshooting
blank pages 137
characters have jagged edges 138
clipped images 138
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color misregistration 148
dark lines 139
gray background 139
light colored line, white line, or
incorrectly colored line 140
poor transparency quality 147
print irregularities 141
print is too dark 142
print is too light 143
print quality test pages 137
repeating defects 145
skewed print 145
solid color pages 145
toner fog or background
shading 146
toner rubs off 146
toner specks 147
uneven print density 148
print troubleshooting
error reading USB drive 131
incorrect characters print 132
incorrect margins 139
jammed page does not
reprint 136
job prints from wrong tray 132
job prints on wrong paper 132
job takes longer than
expected 132
jobs do not print 131
Large jobs do not collate 133
paper curl 140
paper frequently jams 136
tray linking does not work 132
unexpected page breaks
occur 133
printer
configurations 8
minimum clearances 7
models 8
moving 114
selecting a location 7
shipping 114
printer control panel 10
factory defaults, restoring 115
printer information
where to find 6
printer menus
AppleTalk menu 77
Custom Types menu 70
Default Source menu 63
Paper Loading 69
Paper Texture menu 66

PictBridge menu 91
Quality menu 84
USB menu 78
Utilities 87
Wireless menu 76
printer messages
30.yy <color> Toner Cart
Missing 126
31.yy Defective Imaging Kit 126
31.yy Replace black and color
imaging kit 126
34 Short paper 127
35 Insufficient memory to support
Resource Save feature 127
37 Insufficient memory for Flash
Memory Defragment
operation 127
37 Insufficient memory to collate
job 127
38 Memory full 127
39 Complex page, some data may
not have printed 128
51 Defective flash detected 128
52 Not enough free space in flash
memory for resources 128
53 Unformatted flash
detected 128
54 Standard <x> software
error 128
54 Standard network software
error 128
56 Standard USB port
disabled 129
58 Too many flash options
installed 129
58 Too many trays attached 129
59 Incompatible tray <x> 129
82 Replace waste toner
box 97, 130
82 Waste toner box missing 130
82 Waste toner box nearly
full 130
88 Cartridge is low 130
88 Replace <color> Cartridge 106
88 Replace <color> cartridge 130
Calibrating 124
Close door 124
Defective <color> Cartridge 126
Imaging Kit 100
Insert Tray <x> 124
Load <input src> with <custom
string> 124

Index

Load <input src> with <custom
type name> 124
Load <input src> with <size> 124
Load <input src> with <type>
<size> 125
Load single sheet feeder with
<custom string> 125
Load single sheet feeder with
<custom type name> 125
Load single sheet feeder with
<size> 125
Load single sheet feeder with
<type> <size> 125
Reload printed pages in Tray
<x> 124
Remove packaging material 126
Remove paper from standard
output bin 126
Replace Unsupported <color>
Cartridge 127
Unplug and change mode 126
Unsupported USB device, please
remove 126
Unsupported USB hub, please
remove 126
printer options troubleshooting
flash memory card 135
memory card 135
multipurpose feeder 135
option not working 134
paper trays 134
printer problems, solving basic 130
printer software, installing
(Windows) 22
printing
directory list 60
font sample list 59
from Macintosh 53
from USB flash memory device 58
from Windows 53
menu settings page 21
network setup page 22
photos 59
print quality test pages 60
printing a document 53
publications
where to find 6

Q
Quiet Mode 35
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R
recycled paper
using 32
recycling
Lexmark packaging 36
Lexmark products 36
toner cartridges 36
WEEE statement 154
reducing noise 35
Reload printed pages in Tray
<x> 124
Remove packaging material 126
Remove paper from standard
output bin 126
Replace Unsupported <color>
Cartridge 127
replacing
developer unit 108

S
safety information 5
setting
Active NIC 73
paper size 38
paper type 38
TCP/IP address 75
Universal Paper Size 38
setting up the printer
on an Ethernet network
(Macintosh only) 29
on an Ethernet network (Windows
only) 29
Setup menu 81
shipping the printer 114
standard tray
loading 39
status of supplies, checking 93
storing
paper 47
supplies 93
supplies
conserving 33
status of 93
storing 93
Supplies menu 62
supplies, ordering
imaging kits 95
toner cartridges 94
waste toner bottle 96
supply notifications
configuring 116

system board
accessing 13

T
TCP/IP menu 75
tips
labels, paper 56
transparencies 55
toner cartridges
ordering 94
recycling 36
replacing 106
transparencies
loading 42
tips 55
tray linking 37
tray unlinking 37
trays
linking 37
unlinking 37
troubleshooting
checking an unresponsive
printer 130
contacting Customer Support 151
FAQ about color printing 149
solving basic printer
problems 130
troubleshooting, display
display is blank 130
display shows only diamonds 130
troubleshooting, paper feed
message remains after jam is
cleared 136
troubleshooting, print
error reading USB drive 131
incorrect characters print 132
incorrect margins 139
jammed page does not
reprint 136
job prints from wrong tray 132
job prints on wrong paper 132
job takes longer than
expected 132
jobs do not print 131
Large jobs do not collate 133
paper curl 140
paper frequently jams 136
tray linking does not work 132
unexpected page breaks
occur 133
troubleshooting, print quality
blank pages 137
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characters have jagged edges 138
clipped images 138
color misregistration 148
dark lines 139
gray background 139
light colored line, white line, or
incorrectly colored line 140
poor transparency quality 147
print irregularities 141
print is too dark 142
print is too light 143
print quality test pages 137
repeating defects 145
skewed print 145
solid color pages 145
toner fog or background
shading 146
toner rubs off 146
toner specks 147
uneven print density 148
troubleshooting, printer options
flash memory card 135
memory card 135
multipurpose feeder 135
option not working 134
paper trays 134

U
Universal Paper Size 71
setting 38
Universal Setup menu 71
unlinking trays 37
Unplug and change mode 126
Unsupported USB device, please
remove 126
Unsupported USB hub, please
remove 126
updating options in printer
driver 23
USB flash memory device 58
USB port 20

W
waste toner bottle
ordering 96
waste toner box
replacing 97
wireless network
configuration information 24
installation, using Macintosh 26
installation, using Windows 25
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wireless network setup
in Windows 25
wireless printer setup
in Macintosh 26

